
 

  



 

 

Page 2 of 105 

Contents 
 
1 Introduction ..................................................................................................................... 6 

2 System overview ............................................................................................................. 7 

2.1 Distinct models ......................................................................................................... 7 

2.1.1 Description ........................................................................................................... 7 

2.1.2 Features ............................................................................................................... 8 

2.2 Components of a ScanFish III ROTV system .......................................................... 8 

2.3 Options extra ............................................................................................................ 9 

2.4 Full system integration ........................................................................................... 10 

3 Quick start guide........................................................................................................... 11 

4 ScanFish III overview ................................................................................................... 12 

4.1 Technical overview ................................................................................................ 12 

4.1.1 Skeleton and body parts .................................................................................... 12 

4.2 Top view of the ScanFish III .................................................................................. 13 

4.3 Bottom view of the ScanFish III ............................................................................. 14 

4.4 Hatches .................................................................................................................. 15 

4.4.1 Top hatches ....................................................................................................... 15 

4.4.2 Side hatches ...................................................................................................... 16 

4.5 Flaps ...................................................................................................................... 16 

4.6 Internal view ........................................................................................................... 18 

4.7 Assembly of deflection wires ................................................................................. 19 

4.7.1 Mounting of the deflection wires on the tow cable ............................................. 19 

4.8 Dynamic specifications .......................................................................................... 20 

4.8.1 Ascend speed and descend speed ................................................................... 20 

4.8.2 Weight of the ScanFish III .................................................................................. 20 

4.8.3 ScanFish III drag ................................................................................................ 21 

4.8.4 Line turns ........................................................................................................... 21 

5 ScanFish III Power & communications ....................................................................... 22 

5.1 Overview ................................................................................................................ 22 



 

 

EIVA ScanFish III manual 2.1.docx 

Last update: 3/6/2019 
Page 3 of 105 

5.1.1 Connector/indicator layout ................................................................................. 22 

5.1.2 Technical specifications ..................................................................................... 23 

5.2 Connecting the ScanFish III Power & communications ......................................... 23 

5.3 Connecting to the ScanFish III ............................................................................... 23 

5.4 Indicator light .......................................................................................................... 23 

6 The ScanFish III Flight software .................................................................................. 24 

6.1 Installation of the ScanFish III Flight software ....................................................... 24 

6.2 Getting started ....................................................................................................... 28 

6.2.1 Connecting to the ScanFish III........................................................................... 28 

6.2.2 The display layout .............................................................................................. 30 

6.3 Main tools ............................................................................................................... 31 

6.3.1 The main menu .................................................................................................. 32 

6.3.2 The toolbar ......................................................................................................... 43 

6.3.3 The main window ............................................................................................... 49 

6.3.4 The status bar .................................................................................................... 49 

6.4 Playback mode ...................................................................................................... 49 

6.5 Configuring the display layout ................................................................................ 50 

6.6 Display panels ........................................................................................................ 52 

6.6.1 The Depth Monitor panel ................................................................................... 52 

6.6.2 The Roll panel .................................................................................................... 52 

6.6.3 The Pitch panel .................................................................................................. 53 

6.6.4 The Tow panel ................................................................................................... 54 

6.6.5 The Messages History panel ............................................................................. 56 

6.6.6 The Data Chart panel ........................................................................................ 56 

6.6.7 The Alert panel .................................................................................................. 58 

6.6.8 The Numeric Panel ............................................................................................ 58 

6.7 Software Interfaces ................................................................................................ 59 

6.7.1 Cable Counter data import ................................................................................. 60 

6.7.2 Cable Counter Data Export................................................................................ 61 

6.7.3 Fish Data Export ................................................................................................ 61 

7 ScanFish III Flight software & NaviPac integration ................................................... 62 



 

 

Page 4 of 105 

7.1 ScanFish III Flight software settings ...................................................................... 62 

7.2 NaviPac settings .................................................................................................... 62 

7.2.1 Cable counter data ............................................................................................ 63 

7.2.2 Interfacing sensors ............................................................................................ 65 

7.2.3 Helmsman’s Display .......................................................................................... 71 

7.2.4 Data logging ....................................................................................................... 73 

8 Payload communications ............................................................................................ 73 

8.1 Requirements ......................................................................................................... 73 

8.2 Digi PortServer ....................................................................................................... 74 

8.3 Advantech ADAM module (optional) ...................................................................... 75 

9 Procedures for use of the ScanFish III ....................................................................... 75 

9.1 Pre-flight ................................................................................................................. 75 

9.2 Deployment of the ScanFish III .............................................................................. 77 

9.3 While operating ...................................................................................................... 77 

9.4 Depth vs. cable length and speed ......................................................................... 79 

9.5 Recovery procedure ............................................................................................... 80 

9.6 Storing of the ScanFish III ..................................................................................... 80 

9.7 Inspection and maintenance .................................................................................. 81 

9.8 Calibration of the ScanFish III Controller ............................................................... 82 

10 Polycarbonate chemical resistance ........................................................................ 84 

11 Failure diagnostics .................................................................................................... 87 

11.1 Visual inspection shows that the flap motor is leaking oil ...................................... 87 

11.2 Visual inspection shows cracks in the outer shells and/or skeleton ...................... 87 

11.3 Visual inspection shows missing paint spots on the inside of the shells ............... 87 

11.4 Visual inspection shows missing/broken oval screw supports on the hatches ..... 88 

11.5 Pre-flight check reports a failure in the flap motor (port/starboard) ....................... 88 

11.6 Pre-flight check reports a failure in the depth sensor ............................................ 89 

11.7 Pre-flight check reports a failure in the motion sensor .......................................... 89 

11.8 Pre-flight check reports a failure in the temperature sensor status ....................... 89 

11.9 Pre-flight check reports a failure in the I/O module ............................................... 89 



 

 

EIVA ScanFish III manual 2.1.docx 

Last update: 3/6/2019 
Page 5 of 105 

11.10 Pre-flight check reports a failure in the battery sensor .......................................... 90 

11.11 Pre-flight check reports a failure in the altimeter ................................................... 90 

11.12 While operating, the ScanFish III cannot reach the desired depth and/or cannot 

keep within the defined depth tolerance ............................................................................ 90 

11.13 While operating, the ScanFish III keeps undulating a few metres up and down 

when in Fixed depth / Follow seabed mode ...................................................................... 91 

11.14 While operating, the ScanFish III Flight software reports connection and/or power 

problems ............................................................................................................................ 91 

11.15 While operating, the ScanFish III cannot keep the roll between -2° and 2° .......... 92 

11.16 Visual inspection shows that the locking ring or cotter pin in the foldable tow arm is 

corroded/broken/missing (ScanFish Tropheus only) ......................................................... 93 

11.17 While operating, the ScanFish III keeps seeking to the surface (ScanFish 

Tropheus only) ................................................................................................................... 93 

12 Repair .......................................................................................................................... 94 

12.1 Removal of POM side panels ................................................................................ 94 

12.2 Refitting of POM side panels ................................................................................. 95 

12.3 Replacing a flap ..................................................................................................... 96 

12.4 Replacing a flap cable............................................................................................ 97 

12.5 Replacing the depth sensor ................................................................................... 97 

12.6 Replacing the controller ......................................................................................... 98 

12.7 Replacing the altimeter .......................................................................................... 99 

12.8 Replacing the locking ring and cotter pin in the foldable tow arm (ScanFish 

Tropheus only) ................................................................................................................. 100 

13 Assembly of the cradle (optional) .......................................................................... 101 

13.1 Cradle parts ......................................................................................................... 101 

13.2 Assembly of the ScanFish III support stands ...................................................... 102 

13.3 Assembly of the sonar support pad ..................................................................... 103 

13.4 Final assembly of the cradle ................................................................................ 104 

14 Version descriptions ............................................................................................... 105 

 



 

 

Page 6 of 105 

1 Introduction 

The ScanFish III is a sophisticated underwater remotely operated towed vehicle (ROTV) for 

use in oceanographic operations in conjunction with a multitude of other equipment and 

software. 

The ScanFish III is a wing-shaped ROTV with port and starboard flaps for low drag and 

good control. Inside the ScanFish III body, there is room for carrying sensor equipment, with 

access to the water column through openings in both side panels. It is also possible to have 

equipment mounted on top of and below the body of the ScanFish III. 

 

 
Figure 1 The ScanFish III 

The ScanFish III is towed behind a ship for propulsion. It moves up and down in the water 

column as desired using its flaps. It features an internal motion sensor with an 

accelerometer, a magnetometer, a gyroscope, an echo sounder for measuring elevation 

from seabed, and a pressure sensor for measuring depth. This enables the ScanFish III to 

be steady in the water, even at high speeds, because of continuous and autonomous 

control of the flaps. This, in turn, makes it a stable platform for underwater operations. 

The ScanFish III features three basic operating modes: 

• Fixed Depth mode: the ScanFish III maintains a stable depth beneath the surface 

• Follow Seabed mode: the ScanFish III maintains a stable elevation above the 

seabed despite fluctuating bottom conditions 

• Undulate mode: the ScanFish III moves up and down in the water column in an 

undulation pattern  

While in operation, the ScanFish III is connected via Ethernet to the surface for constant 

monitoring and control. For some models, the uplink also enables constant transmission of 

data from a variety of sensors to EIVA NaviPac or other software. 

Distinct models with distinct features exist to cover a variety of operational needs. These are 

described in Chapter 2 ‘System overview’. 
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2 System overview 

2.1 Distinct models 

2.1.1 Description  

The ScanFish Rocio 

The ScanFish Rocio is designed for oceanographic surveying. It is equipped with six 

payload ports for communication with different sensors. Communication can be serial (RS-

232/422/485), analogue (ADC) and digital (Ethernet). All payload ports are accessible via 

Ethernet from computers connected to the ScanFish III Power & communications. 

The ScanFish Rocio has multiple brackets for internal mounting of equipment (eg sound 

velocity profiling (SVP) sensors, water pumps, additional multiplexers, etc). It can also be 

fitted with brackets for external mounting of equipment (eg cameras and laser optical 

plankton counters (LOPC)). 

The ScanFish Katria 

The ScanFish Katria is designed for wide-sweep magnetometer surveys. It features a 

reinforced skeleton and two side extensions that give the ScanFish Katria a total width of 

5.051 metres. Towed from the side extensions are four Geometrics G-882 Marine 

Magnetometers. The magnetometers are towed at a distance of 4 metres to avoid picking 

up interference from the ScanFish Katria’s stainless steel skeleton. 

The ScanFish Konia 

The ScanFish Konia is designed for sound velocity profiling. It features an integrated SVP 

sensor mounted inside the ScanFish III body. This enables continuous collection of up-to-

date SVP data from the entire water column through the ScanFish III’s Undulate mode and 

real-time data uplink. 

The ScanFish Tropheus 

The ScanFish Tropheus is designed for unexploded ordnance (UXO) operations. It is 

completely integrated with side-scan sonar (SSS). The SSS is towed underneath and 

behind the ScanFish III in a special foldable tow arm. 
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2.1.2 Features 

Feature Rocio Katria Konia Tropheus 

Real-time flight data ● ● ● ● 

High-speed surveying (up to 10 kn) ●  ● ● 

6 x payload ports ●    

Power supply (24 V & 48 V DC) for instruments ●    

Integrated SVP sensor   ●  

Full integration with side-scan sonar    ● 

Space for internal mounting of extra sensors ●    

Table 1 ScanFish III features 

2.2 Components of a ScanFish III ROTV system 

A standard ScanFish III ROTV system includes the components listed in Table 2. The 

specific components of individual systems vary based on the individual order. 

 

Item Rocio Katria Konia Tropheus 

EIVA ScanFish III ROTV ● ● ● ● 

EIVA ScanFish III Flight software ● ● ● ● 

EIVA ScanFish III Power & communications 

(topside unit) 
● ● ● ● 

Cable termination and tow point ● ● ● ● 

Deck cable (30 m) ● ● ● ● 

Rejection wires  ● ● ● ● 

Multiplexer ●    

Side-scan sonar    ● 

Magnetometers  ●   

AML Smart-X SVP sensor   ●  

Case ● ● ● ● 

Cradle    ● 
Table 2 ScanFish III components 
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2.3 Options extra 

As an extra option it is possible to retrofit 3D steering to the ScanFish series or as part of a 

new unit. The 3D steering options makes horizontal movement control possible for the 

ScanFish series. Figure 2 below illustrates a ScanFish III fitted with the 3D steering option 

on both starboard and port sides.    

 
Figure 2 ScanFish 3D steering 

The 3D steering option can be fitted to all the ScanFish series, see Table 3 below.  

 

Table 3 Options extra 

Feature Rocio Katria Konia Tropheus 

3D steering ● ● ● ● 
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2.4 Full system integration 

 
Figure 3 Illustration of a fully integrated ScanFish III system 

In order to utilise a ScanFish III system, it needs to be integrated into a larger survey setup. 

The following items and objects are needed for ScanFish III operation: 

• A ship, as a base of operations and for towing the ScanFish III 

• An A-frame or crane or similar, for lifting the ScanFish III in and out of the water 

• A winch with slip ring and tow cable, for towing the ScanFish III and connecting the 

tow cable to the deck cable 

• A cable counter (optional), for managing cable length and calculating approximate 

distance from the vessel to the ROTV 

• A deck cable, for connecting the winch and tow cable to the ScanFish III Power & 

communications 

• A ScanFish III Power & communications, a power supply and communications link 

for the ScanFish III and sensors 

• A computer, for running the ScanFish III Flight software and data collection 

• A ScanFish III 

• Sensors, for collection of relevant data 
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3 Quick start guide 

Important: This is a quick guide to getting started with using the ScanFish III. It is not a full 

description of procedures for handling the ScanFish III. For explicit directions, see the 

relevant following sections. It is important to read and understand the explicit instructions for 

handling the ScanFish III, not least for safety reasons. 

Before you begin: 

• Check that the system is complete and that nothing is missing and/or damaged 

• Check that the system is connected correctly 

• ScanFish III > Tow point > Slip ring > Deck cable > ScanFish III Power & 

communications > Computer 

• Make sure that the computer is running and has the ScanFish III Flight software 

installed (see Section 6.1 ‘Installation of the ScanFish III Flight software’) 

Operation: 

• Connect the AC power and the power on the ScanFish III Power & communications 

• Wait for the connection to automatically be established (see Section 5.3 

‘Connecting to the ScanFish III’) 

• Make sure the payload communication (COM) ports are configured ( for the 

ScanFish Rocio / ScanFish Konia only) (see Chapter 8 ‘Payload communications’) 

• Perform the pre-flight check as defined in Section 9.1 ‘Pre-flight’ 

• Deploy the ScanFish III (see Section 9.2 ‘Deployment of the ScanFish III’) 
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4 ScanFish III overview 

4.1 Technical overview 

Type Value Tolerance 

Input voltage 300 V ±5% 

Maximum power consumption 300 W Not applicable 

Available external power1 
50 W on 24 V  

130 W on 12 V 
±5% 

Maximum depth 400 m Not applicable 

Minimum recommended operating sea depth 5 m Not applicable 

Maximum tow speed 10 kn Not applicable 

Uplink data bandwidth2 1–7 Mbit/s ±20% 

External communication3 
RS-232/422/485, 

Ethernet, ADC 
Not applicable 

Table 4 ScanFish III technical overview 

4.1.1 Skeleton and body parts 

The entire ScanFish III skeleton and all metal parts are made of marine grade corrosion 

resistant stainless steel W1.4404/AISI 316L. 

For information on the chemical resistance of the acrylic shells, see Chapter 10 

‘Polycarbonate chemical resistance’ 

The side panels are made of polyethlyen high density (PEHD). 

                                                      
1 Available external power may vary depending on specific model/application. 
2 Data bandwidth varies with cable length/application. This is set and fixed at fabrication according to customer 

specifications. 
3 Configuration is customer-specific. See description of specific model and order. 
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4.2 Top view of the ScanFish III 

 
Figure 4 Top view of the ScanFish III 

1. Tow cable 

2. Deflection wires 

3. Cable termination 

4. Tow point 

5. Hatch, port 

6. Hatch, starboard 

7. Flap, port 

8. Flap, starboard 

9. Tail guard 

10. Side guard 

11. Side plate 2D, port 

12. Side plate 2D, starboard 

13. Depth sensor  
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4.3 Bottom view of the ScanFish III 

 
Figure 5 Bottom view of the ScanFish III 

1. Tow cable 

2. Deflection wires 

3. Cable termination 

4. Tow point 

5. Altimeter 

6. Flap, port 

7. Flap, starboard 

8. Tail guard 

9. Side guard 

10. Side plate 2D, port 

11. Side plate 2D, starboard 

12. Depth sensor 
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4.4 Hatches 

4.4.1 Top hatches 

The top hatches can be removed by unscrewing the screws in each of the nine oval screw 

supports. Do not loosen screws without the oval screw support. 

 
Figure 6 Oval screw support 

Removing the hatch gives access to the inside of the ScanFish III for maintenance and/or 

replacement of parts.  

When mounting the hatches, be sure to fasten all screws – but do not over-tighten. Never 

deploy the ScanFish III without hatches or with screws missing.  
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Figure 7 Top view of the ScanFish III with port hatch removed 

4.4.2 Side hatches 

The side panels of the ScanFish Rocio, the Scanfish Katria and the ScanFish Konia have 

round side hatches that each can be removed by unscrewing four screws. There are three  

side hatches on each side of the ScanFish Rocio and the ScanFish Katria, and one side 

hatch on each side of the ScanFish Konia. The ScanFish Tropheus does not have any side 

hatches. 

The side hatches can be seen in the illustration in Figure 8. These hatches allow payload 

equipment to access the water column if needed, while the side guards protect extruding 

equipment. 

Special hatches that have smaller openings for better mounting of cables or small sensors 

can be made to order.  

4.5 Flaps 

The flaps can move 40º ±2º in either direction. The centre position is 0º. Positive angle is 

downward in the direction indicated by the arrow in Figure 8. 
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Figure 8 Positive direction of flap angle: the ScanFish III is pictured with the starboard flap 

at approximately -10º  
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4.6 Internal view 

In the ScanFish III, the controller, which contains communications, power supply, payload 

connections and control systems, is located in the centre of the body. The altimeter is 

mounted on the port side of the tow point. 

Payload equipment such as sensors, analogue/digital I/O modules, water pumps, 

multiplexers, magnetometers etc can be mounted in the ScanFish III side hatches. 

The controller can be shifted left/right to accommodate sensor positioning and properly 

balance the ScanFish III. The altimeter, however, is fixed in its position. 

 
Figure 9 Internal view of the ScanFish III seen from the top 
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4.7 Assembly of deflection wires 

 

 

 
Figure 10 ScanFish III deflection wire bracket 

The purpose of the deflection wires is to prevent the ScanFish III from getting caught in 

fishing nets and similar items. 

4.7.1 Mounting of the deflection wires on the tow cable 

 
Figure 11 Tow cable deflection wire bracket 
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Mount the deflection bracket on the tow cable and mount the shackles for the deflection 

wires as marked by the red arrows. Take care not to damage the tow cable by over-

tightening the screws in the bracket. 

Caution: Do not use the deflection wires for lifting the ScanFish III, and do not attach 

or connect other items to the wires/brackets. The deflection wires may not be able to 

deflect all objects in the water, so take care when using the ScanFish III. Avoid sailing 

through water containing debris or objects that could harm the ScanFish III in the 

case of a collision or by getting caught up in the system, as this may damage the 

ScanFish III and the tow cable. The deflection wire is only designed for the standard 

ScanFish III. 

4.8 Dynamic specifications 

4.8.1 Ascend speed and descend speed 

Ascend and descend speeds, for the Undulate mode, are user configurable, but EIVA 

recommends the default setting. Ascend and descend speeds cannot be configured with 

different values; they must be the same as one another. 

 

Direction Min speed (m/s) Default (m/s) Max speed (m/s)  

Ascend 0.1 0.6 3 

Descend 0.1 0.6 3 

Table 5 ScanFish III ascend and descend speeds 

4.8.2 Weight of the ScanFish III 

The weight of the ScanFish III depends on the customer configuration. With the default 

configuration, the weight is as shown in  

Rocio 3D 122 54 

Katria 3D* 152 89 

Table 6. 

 

ScanFish III series 
Weight (kg) 

Air Freshwater 

Rocio 75 36 

Katria* 134 71 

Rocio 3D 122 54 

Katria 3D* 152 89 
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Table 6 ScanFish III weight 

*Excl G882 magnetometers and poles 

4.8.3 ScanFish III drag 

This is the calculated theoretical drag for the ScanFish III (not including cable), for use in 

winch calculations. The drag is for normal operation. If the ScanFish III malfunctions, 

collides, etc, the drag can be much greater. 

 

ScanFish III series 
Drag force 

[N] [kg] 

Rocio 100 10.2 

Katria* 280 28.5 

Rocio 3D 120 12.2 

Katria 3D* 300 30.5 

 

Table 7 ScanFish III drag 

*Drag at 4 [knt] STW 

4.8.4 Line turns 
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5 ScanFish III Power & communications  

5.1 Overview 

5.1.1 Connector/indicator layout 

 
Figure 12 ScanFish III Power & communications front view 

1 Power on/off – Power indicator 

2 Indicator light 

 

 
Figure 13 ScanFish III Power & communications rear view 

Red: AC power in (IEC C14 connector) – Fuse 1 (in connector) 

Blue: Fuse 2 – DC 

Green: Deck cable connecter (UHF Connector) 

Yellow: RJ-45 Ethernet connector 
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5.1.2 Technical specifications 

Type Value Tolerance 

Input voltage 110–230 V ±20 V 

Maximum power consumption 310 W  Not applicable 

Fuse 1 - AC  2 A Slow blow 

Fuse 2 - DC 1 A Slow blow 

Ingress Protection rating IP40 Not applicable 

Communication BASE10 Ethernet (LAN) Not applicable 

Table 8 ScanFish III Power & communications technical specifications 

5.2 Connecting the ScanFish III Power & 

communications 

1. Connect the Ethernet (RJ-45) cable to LAN or host computer 

2. Connect the ScanFish III to the ScanFish III Power & communications through 

deck/tow cable 

3. Connect the power cord to the AC supply 

5.3 Connecting to the ScanFish III 

1. Complete the steps in Section 5.2 ‘Connecting the ScanFish III Power & 

communications’ 

2. Turn on the ScanFish III Power & communications 

3. Wait for the ScanFish III Power & communications to establish connection  

4. The indicator light will turn solid green upon connection 

5.4 Indicator light 

Colour Indication  

Solid red No connection – the ScanFish III is not connected, or noise is too severe 

Blinking red Trying to establish connection 

Solid orange Connected, but with communication errors 

Solid green Connection is good 

Table 9 ScanFish III Power & communications indicator light interpretation 
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6 The ScanFish III Flight software 

6.1 Installation of the ScanFish III Flight software 

The ScanFish III Flight software includes a setup wizard that will guide you through the 

installation. 

 

Click Next > to continue. 

 

 

  

Figure 14 ScanFish III Flight software setup wizard 
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Read the license conditions, and if accepted, select the I accept the terms of the License 
Agreement check box, after which you can install the software. 

If you do not accept the license conditions, click Cancel and abort the installation. 

 

 

Use the default destination folder or choose a different location for the installation, and then 

click Next >. 

Figure 16 Install location 

Figure 15 End-user licence agreement (EULA) 
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Figure 17 Start menu folder selection 

Use the default Start menu folder or choose a different Start menu folder in which to save 

the ScanFish III Flight software’s shortcuts, and then click Next >. 

 

 
Figure 18 Optional shortcuts 

Select the check boxes if you want a shortcut created on the Desktop and/or the Quick 

menu, and then click Install. 
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Figure 19 Installation progress 

The installation is quickly completed on modern computers. Click Next > to continue to the 

final setup wizard screen. 

 
Figure 20 Installation completed 

Leave the Run ScanFish3 Flight check box selected and click Finish to close the setup 

wizard and launch the ScanFish III Flight software, or clear the Run ScanFish3 Flight 

check box to finish the installation without running the ScanFish III Flight software. 
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6.2 Getting started 

When the ScanFish III Flight Software is started, the user interface is setup in the default 

layout, as shown in Figure 21. Information on how to rearrange and reconfigure the layout is 

provided in Section 6.5 ‘Configuring the display layout’. 

 
Figure 21 The ScanFish III Flight software at startup 

6.2.1 Connecting to the ScanFish III 

Initially, the ScanFish III must be connected to the ScanFish III Power & communications, 

and the ScanFish III Flight software must in turn be run on a computer connected to the 

ScanFish III Power & communications. This is illustrated on the right side of Figure 22.  
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Figure 22 ScanFish III Flight software relations and dataflow 

Once the physical network configurations are in place, the software connections must be 

established. The IP address of the ScanFish III must be configured in the ScanFish III Flight 

software. This configuration can be done by clicking Settings > Options > Fish > Fish 

connection. The Fish connection property is shown in Figure 23. 

 
Figure 23 Options dialogue box with focus on Fish properties 
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The IP address of the ScanFish III is by default ‘http://10.10.103.xx’, where xx is the last two 

digits of the ScanFish III’s serial number. 

Once the settings are acceptable, the user must click Ok at the bottom of the dialogue box. 

To connect to the ScanFish III, click the Connect button on the toolbar. The ScanFish III 

Flight software will then begin connecting to the ScanFish III. Once a connection has been 

established, the user must follow the operating instructions for how to operate the ScanFish 

III, including the pre-flight check and visual inspection, before deployment into the water 

(see Section 6.3.2.1.2 ’Pre Flight Check’ for further details on this issue). 

6.2.2 The display layout 

The display layout of the ScanFish III Flight software can be configured to meet the 

individual needs of the user. The ScanFish III Flight software main window consists of a 

number of dockable panels that can be toggled on/off by the user under View > Dockable 

views. 

The panels can float freely inside the ScanFish III Flight software main window. They can 

also be docked to the edges of the windows, or they can float onto a secondary screen if 

one is present.  

In Figure 24, a typical example of a ScanFish III Flight software display layout is provided. 

 
Figure 24 The ScanFish III Flight software display layout 

The display layout is saved automatically and will be used the next time the ScanFish III 

Flight software is started. Further details on how the display is configured are given in 

Section 6.5 ‘Configuring the display layout’. 
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6.3 Main tools 

The ScanFish III Flight software is organised in different menus and panels that together 

make the user interface as illustrated in Figure 25. The various tools are as follows: 

• Main menu 

• Toolbar 

• Main window 

• Status bar 

 

 

Figure 25 The ScanFish III Flight software tools 
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6.3.1 The main menu 

The ScanFish III Flight software main menu has four menu items: File, View, Settings and 

Help. 

6.3.1.1 The File menu 

 
Figure 26 File menu 

The File menu shown in Figure 26 has the following menu items: 

• New Project (Ctrl + N): This menu item facilitates the creation of a new setup. Note 

that the ScanFish III Flight software will not allow the user to create a new setup 

when a connection to the ScanFish III has been established or when the software is 

running in playback mode. 

• Open Project (Ctrl + O): With this menu item, a previously saved project (Flight 

Setup) can be loaded. The extension of the project is .sf3f. 

• Save Project (Ctrl + S): This menu item allows the user to save the current project 

(Flight Setup). If the project has not been saved previously, the user is prompted to 

select a name for the project.  

• Save Project As: This menu item allows the user to save the current project (Flight 

Setup) under a name selected by the user. 

• Playback File: This menu item will make the ScanFish III Flight software enter 

playback mode. Prior to that however, the user is prompted to select a file to 

perform the playback on. The ScanFish III Flight software will automatically record 

all data from the ScanFish III during flight, and these files, with extension .sfl, are 

used for the playback. Details on the playback mode are given in Section 6.4 

‘Playback mode’. 
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• Unpack Log File: This menu item will extract the compressed log files (extension 

.sfl) to an ASCII text file that can be used for error detection. Observe that the ratio 

between the file sizes is approximately 1:50. During extraction, a progress bar is 

shown ( Figure 27), and when extraction is completed, a completion message will 

appear (Figure 28). 

• Connect: This menu item will start the connection process between the software 

and the ScanFish III in accordance with the settings defined in Options > Fish > 

Fish Connection (see Section 6.2.1 ‘Connecting to the ScanFish III’ for further 

details).  

• Note that the Connect menu item is only active when no connection has 

been established. 

• Disconnect: This menu item will disconnect the software from the ScanFish III. The 

menu item is only active when a connection has been established or when the 

ScanFish III Flight software is executed in playback mode. 

• Exit: This menu item stops the ScanFish III Flight program. Note that the user is not 

prompted to confirm whether he wants to stop the software or not. If, however, the 

program is connected to the ScanFish III, the user will be instructed to disconnect 

before attempting to exit. 

 

 

 Figure 27 Progress bar 

 

 Figure 28 Completion message 
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6.3.1.2 The View menu 

 
Figure 29 View menu 

The View menu shown in Figure 29 is related to the view of the eight different panels. The 

ScanFish III Flight software main window consists of a number of dockable panels that can 

be toggled on/off and moved inside as well as outside the main window. Details on the 

panels are given in Section 6.5 ‘Configuring the display layout’. 

6.3.1.3 The Settings menu 

 
Figure 30 Settings menu 

The Settings menu shown in Figure 30 has three menu items: Themes, Reset Layout and 

Options. 

6.3.1.3.1 Themes 

Themes is a submenu that is shown in Figure 31: 

 
Figure 31 Themes submenu 
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The user can choose different, predefined themes from this submenu. Each theme will 

supply predefined background and frame colours for the panels. Displayed from left to right 

in Figure 32, the themes selected for the Numeric panel are: Aero, Classic, Luna, Dev 

2010 and Expression Dark. The Numeric panel on the far right is created by pointing to 

Themes on the Settings menu, pointing to Color, and then clicking Red. 

      
Figure 32 The ScanFish III Flight software colour themes 

6.3.1.3.2 Reset Layout 

When the user clicks Reset Layout, the ScanFish III Flight software will reset panel 

positions and size to the default layout, which is shown in Figure 24. 

6.3.1.3.3 Options 

Clicking Options on the Settings menu opens the Options dialogue box, which allows the 

user to modify the configuration of the software. For this task, five different items are 

available in the Setup list, as shown in Figure 33: 

• Fish 

• Winch and Cable Counter 

• Exporters 

• Logging 

• Importers 

• User Interface 
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Figure 33 Options dialogue box at startup 

When Fish is selected, the properties shown in Figure 34 will appear in the properties pane 

on the right side of the Options dialogue box. 

 
Figure 34 Fish properties 

• In Fish connection, the user can define the connection to the ScanFish III by 

entering the IP address. Note that the default value is ‘http://10.10.103.xx’, where xx 

is the last two digits of the ScanFish III’s serial number. 

• The Fish driver must be ‘ScanFish3’, which is the only driver implemented. The 

user can choose ‘None’ if the ScanFish III Flight software should be used without a 

ScanFish III. 

• Reply Timeout is used to define timeout settings for communication with the 

ScanFish III. Note that the actual intervals might vary slightly, however, the default 

value of ‘500 ms’ will work in most cases. 

• Retry attempts is used to define how many times the software will attempt to 

contact the ScanFish III before alerting the operator about a lost connection. 

• Status Polling Interval is used to define the interval between statuses being 

requested from the ScanFish III. 
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Winch and Cable Counter properties are described in Section 6.7 ‘Software Interfaces’. 

Exporters is described in Section 6.7.2 ‘Cable Counter Data Export’ and Section 6.7.3 ‘Fish 

Data’. 

Logging is associated with the constant logging of all ScanFish III flight data during flight. 
The files logged can be used as input for the playback mode, as described in Section 6.4 
‘Playback mode’. 

When Logging is selected, the properties shown in Figure 35 will appear in the properties 

pane on the right side of the Options dialogue box. 

 
Figure 35 Logging properties 

• Log Expiration Date allows the user to only keep logs/files that were created within 

a specified time range. Note that even though it is not possible to disable logging, 

with this property, the ScanFish III Flight software can be configured to 

automatically delete files stored in the default logging folder that are older than the 

number of days specified here. 

• In Logging Folder, the user can specify the folder in which the ScanFish III Flight 

software will save logs. The default folder is C:\temp\ScanFish\Log\. It is, however, 

recommended to use a dedicated (project) folder for the logging in order to avoid 

inadvertently deleting files that have been logged in connection with a previous 

session or project. 
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User Interface can be expanded to show seven subitems. Each of them is associated with 

a particular panel that can be activated and shown in the ScanFish III Flight software main 

window. Further details are given in Section 6.5 ‘Configuring the display layout’. 

• Depth Monitor Panel 

• Alert Panel 

• Message Panel 

• Data Chart Panel 

• Tow Panel 

• Numeric Panel 

• Shortcuts 

Selecting Depth Monitor Panel will open the properties displayed in Figure 36. The 

properties allow for the changing of colours associated with the Depth Monitor panel. 

Details on how to handle the panel can be found in Section 6.5 ‘Configuring the display 

layout’. 

 
Figure 36 Depth Monitor Panel properties 

• Grid Color facilitates definition of the colour of the grid of the Depth Monitor panel. 

When the user clicks Grid Color (or any property associated with definition of 

colour), a colour selection box as displayed in Figure 37 will open. Note that it is 

divided into three tabs: Custom (left), Web (middle) and System (right). The user 

can choose between the large variety of colours supplied, and it is also possible to 

define custom colours, based on an RGB colour scheme, by manually typing in the 

three components. 

 

   

Figure 37 Colour selection box 
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• Shallow Water Color is used together with Deep Water Color to make a faded 

transition, in terms of colouring, between the shallow and the deep water 

visualisation in the Depth Monitor panel. 

• Depth Mode is used to facilitate definition of the two depth modes, Auto mode and 

Fixed mode. Auto mode does not require any settings to be defined, whereas for 

Fixed mode, the user must specify the maximum and minimum depths, as shown in 

Figure 38. 

 

 

Figure 38 Depth Mode properties 

Additionally, with a series of subitems under Depth Monitor Panel, it is possible to define 

the colour and other properties of the lines associated with Ship Bottom Line, Fish Depth 

Line, Fish Bottom Line and Fish Target Line. In the particular case shown in Figure 39, 

the Fish Bottom Line properties are displayed: 

 
Figure 39 Fish Bottom Line properties 

• Color is defined in connection with the Grid Color definition described earlier in this 

section. 

• Draw as Bottom is a Boolean that allows the user to specify whether the line 

should be drawn with a fading effect to resemble the ocean bottom. 

• Max Data Points defines the number of data points to be displayed simultaneously. 

• Pen Size defines the size (thickness) of the line. The default value is ‘2 pixel’. 

Alert Panel allows for definitions associated with the Alert panel. Details on how to handle 

the panel can be found in Section 6.5 ‘Configuring the display layout’. The properties for 

Alert Panel are shown in Figure 40. 

 

  
Figure 40 Alert Panel properties 
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Note that the properties are divided into three categories, each linked to an alert status (Ok, 

Warning and Alert), and each alert status has the same subdivision. The subdivision is: 

• Color defines the colour of the text for the alert status in question. 

• Background Color defines the colour of the background for the alert status in 

question. 

Message Panel is associated with the Messages History panel. The properties for 

Message Panel are shown in Figure 41. The properties are divided into four categories, 

one for the overall background and one each for the three message types: Message, 

Warning and Alert. 

 
Figure 41 Message Panel properties 

• Background Color is used to define the overall colour of the background of the 

Message History panel. 

• Message Color is used to define the colour in which the messages are written. Note 

that the settings for Warning Color and Alert Color can be defined in the same way. 

• Message Background Color is used to define the background colour upon which 

the messages are written. The settings for the Warning Background Color and 

Alert Background Color can be defined in the same way. 

Data Chart Panel is associated with the Data Chart panel. Details on how to handle the 

panel can be found in Section 6.5 ‘Configuring the display layout’. The properties for Data 

Chart Panel are shown in Figure 42. 

  
Figure 42 Data Chart Panel properties 

• Background BackColor is used to define the colour of the background of the Data 

Chart panel. 

• Depth Mode is used to facilitate definition of the two depth modes, Auto mode and 

Fixed mode. Auto mode does not require any settings to be defined (see Figure 42 

on the left), whereas for Fixed mode, the user must specify the maximum and 

minimum depths (see Figure 42 on the right). 
• Grid Color defines the colour of the grid of the Depth Monitor panel.  
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Tow Panel is associated with the Tow panel. The properties for Tow Panel are shown in 

Figure 43. 

 
Figure 43 Tow Panel properties 

• Color is used to define the colour of the background of the Tow panel. 

• Touch Size is used to define the size of the text field after an item has been 

selected for editing. This is shown in Figure 44 (prior to and after editing shown on 

the left, and during editing shown on the right). 

 

  

Figure 44 Touch Size prior to and during editing 

Numeric Panel is associated with the Numeric panel. The properties for Numeric Panel are 

shown in Figure 45. The only property available is associated with the Background Color 

that is used to define the overall background colour of the panel. 

 
Figure 45 Numeric Panel properties 

Shortcuts enables the user to set keyboard shortcuts for the different flight modes. The 

default shortcuts are shown in Figure 46. 

 
Figure 46 Shortcuts properties 
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6.3.1.4 The Help menu 

 
Figure 47 Help menu 

The Help menu has two menu items, About and Firmware.  

Clicking About opens the About window, which shows the software version number (Figure 

48 on the left).Links to online support and offline release notes are available by clicking the 

Ellipsis (…) button (Figure 48 on the right). 

 
Figure 48 About window 

Clicking Firmware opens the Firmware Information window, which shows the firmware 

version of the ScanFish III (Figure 49) if any is connected.  

 
Figure 49 Firmware Information window 
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6.3.2 The toolbar 

The ScanFish III Flight software toolbar contains ten buttons/features (see Figure 50). The 

toolbar is always shown in the ScanFish III Flight software window. It cannot be hidden. 

Some buttons may be unavailable, depending on the present status and/or mode of the 

ScanFish III. In the toolbar shown in Figure 50, the Disconnect button is available instead 

of the Connect button, and the Pre Flight Check button is unavailable because a 

connection is established to the ScanFish III and the ScanFish III is in operation, 

respectively. 

Note that none of the buttons (except Connect/Disconnect) available from the toolbar are 

accessible from any other location in the software. 

 
Figure 50 The ScanFish III Flight software toolbar 

The toolbar is divided into two parts separated by a vertical line (see Figure 50): 

• One part with seven buttons associated with online situations. This part is located 

on the left of the toolbar. 

• One part with three buttons associated with the playback mode. This part is located 

on the far right of the toolbar. 

6.3.2.1 Online toolbar tools 

The online part of the toolbar has the following buttons: 

• Connect/Disconnect 

• Pre Flight Check 

• Flight Mode 

• Undulate Down 

• Undulate Up  

• Parking 

• Emergency Up 

6.3.2.1.1 Connect/Disconnect 

The Connect/Disconnect button of the online toolbar is used to establish/terminate a 

connection between the ScanFish III Power & communications and the ScanFish III. When 

no connection is established, the button is labelled Connect, as shown in Figure 51 on the 

left. Once the connection to the ScanFish III is established, the button is labelled 

Disconnect, as shown in Figure 51 on the right. 
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Figure 51 Connect/Disconnect button 

The action associated with the button is similar to the action associated with the menu items 

File > Connect and File > Disconnect that is described in Section 6.3.1.1 ‘The File menu’. 

Before establishing the connection, however, the physical connections must be in place, 

and the IP address of the ScanFish III must be configured in the ScanFish III Flight software 

under Settings > Options > Fish > Fish connection, as shown in Figure 52. Details on the 

Fish settings are given in Section 6.3.1.3.3 ‘Options’. 

 
Figure 52 Fish properties 

If the software is not capable of establishing the connection to the ScanFish III within the 

timeout and retry attempts ranges specified in the Fish properties, an error message is 

issued in the Messages History panel, as shown in Figure 53. Note that a similar error alert 

is issued in the Alert View panel: 

 
Figure 53 Messages History panel 
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6.3.2.1.2 Pre Flight Check 

The Pre Flight Check mode is a mode that the ScanFish III will automatically enter into 

when powered up. It includes an automatic diagnostic test that, if successful, will allow the 

ScanFish III to go directly into the On Deck mode (for details on this mode, see Section 

6.3.2.1.3 ‘Flight mode’). 

The automatic pre-flight check includes the following: 

• Check of the flap motor(s) 

• Check of the depth sensor 

• Check of the motion sensor 

• Check of the temperature sensor 

• Check of the I/O module 

• Check of the battery sensor 

In particular, the user must check that both flaps are moving to their extreme positions (up 

and down) and back again to the initial position. At the same time, the user must check that 

the depth sensor shows a value of approximately ‘0.00’ once the check has been 

completed. 

Appropriate alerts will be given if any of the checks fail. Important: It is strongly 

recommended that these checks be supplemented by a thorough visual inspection of the 

ScanFish III. Details on this, as well as of the automatic pre-flight check, are given in 

Section 9.1 ‘Pre-flight’. 

6.3.2.1.3 Flight mode 

The ScanFish III can enter a series of different flight modes. These are accessible from the 

Flight Mode button on the online toolbar. Note that when the ScanFish III Flight software is 

started, the default mode is Power on mode. The available flight modes are: 

• On Deck 

• Surface 

• Parking 

• Fixed Depth 

• Follow Seabed 

• Undulate Down 

• Undulate Up 

When one of the modes is selected, the Flight Mode button label will change accordingly, 

as demonstrated in Figure 54. 

 
Figure 54 Flight Mode button 
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The different modes must be entered and selected by the user. This is done from the menu 

that opens after clicking the Flight Mode button (see Figure 55). 

 
Figure 55 Flight Mode menu 

The main characteristics of the flight modes are: 

• In On Deck mode, the ScanFish III is ready to be deployed and will consequently 

not attempt to navigate. This mode must always be employed when handling the 

ScanFish III on deck and during the initial stages of deployment. 

• In Surface mode, the ScanFish III will go to or stay at the water surface and wait to 

be given commands to either dive or to be taken out of the water. 

• Parking mode can be entered by selecting Parking from the menu that opens after 

clicking the Flight Mode button or by clicking the Parking button directly on the 

online toolbar. This mode will send the ScanFish III to the parking depth, whose 

parameters are defined in the Tow panel. See Section 6.3.2.1.4 ‘Parking’ for further 

details. 

• In Fixed Depth mode, the ScanFish III will remain at a predefined fixed depth 

beneath the surface that has been defined in the Tow panel. 

• In Follow Seabed mode, the ScanFish III will maintain a fixed height above the 

seabed that has been defined in the Tow panel. This mode is particular useful in 

connection with side-scan sonar surveys. 

• In Undulate Down mode and Undulate Up mode, the ScanFish III will move in an 

undulating, continuous V-pattern between maximum depth and minimum depth at a 

predefined undulate rate defined in metres per second (for both the ascent and the 

descent) in the Tow panel. Note that the only difference between the two Undulate 

modes is the initial undulation direction. 
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6.3.2.1.4 Parking 

When Parking mode is selected by clicking the Parking button, the ScanFish III will go to 

the parking depth defined in the Tow panel (see Figure 56). Details on how this panel is 

configured are given in Section 6.5 ‘Configuring the display layout’.  

Note that the Parking mode can also be entered through the Flight Mode menu, as 

described in Section 6.3.2.1.3 ‘Flight mode’. 

 
Figure 56 Tow panel 

6.3.2.2 Playback toolbar tools 

The playback part of the toolbar has three buttons: 

• Pause/Play 

• Play Speed 

• Goto Time 

 

The buttons are only available when playback mode is activated. More details on the 
playback mode are found in Section 6.4 ‘Playback mode’. 

6.3.2.2.1 Pause/Play 

Like the other two playback buttons, the Pause/Play button is only available when playback 

is activated. Clicking Pause will pause the progress of the playback, and the button label 

will now change to Play to indicate that the next time the user clicks the button, playback 

will resume. Figure 57 shows the button as it appears while in Play mode (left) and Pause 

mode (right). Note that the current time position is included the label in both modes. 

  
Figure 57 Pause/Play button 
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6.3.2.2.2 Play Speed 

When the user clicks the Play Speed button, a menu will open, as shown in Figure 58 on 

the left. From this menu, it is possible to choose playback speed. 

  
Figure 58 Play Speed drop-down menu 

The default playback speed is always 1x Speed when first initiating the playback mode. 

This means that the playback speed is set at the rate of 1:1 with respect to the acquisition 

speed. From the Play Speed menu, it is possible to change the playback speed to one of 

the other options shown in Figure 58. Once a playback speed has been selected, the 

selected value will be included in the button label, as shown in Figure 58 on the right. Note 

that the maximum speed (Max Speed) is 60x. 

6.3.2.2.3 Goto Time 

When the user clicks the Goto Time button, the dialogue box shown in Figure 59 will open, 

allowing the user to choose a time position that the playback should jump to. When the 

dialogue box opens, the current time position is displayed. 

 
Figure 59 Goto Time dialogue box 

Once the user has entered a time position and clicked OK, the playback will jump to the 

selected time position, and the playback will begin from there. Note that both the hour and 

minute components must be specified in order for the playback to jump backward/forward. 

Should the user enter a time position outside the range of the present file, the playback 

operation will temporarily stop. Choosing a time position inside the range covered will make 

the playback begin from there. 
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6.3.3 The main window 

The layout of the main window can be defined by the user. The window consists of a 

number of dockable panels that can be toggled on/off using the View menu. In addition, the 

panels can float freely inside the ScanFish III Flight software main window. They can be 

docked to the edges of the windows, or they can float onto a secondary screen if one is 

present. Further details on how the main window can be configured are given in Section 6.5 

‘Configuring the display layout’. 

6.3.4 The status bar 

The status bar does not have any information displayed at present (it will constantly display 

‘Flight Status’). 

6.4 Playback mode 

As stated in Section 6.3.1.1 ‘The File menu’, the ScanFish III Flight software automatically 

records all data from the ScanFish III during flight. The ScanFish log files that have been 

recorded can be used to enter playback mode. In playback mode, it is possible to show the 

situation as it actually occurred during flight/acquisition. 

The playback mode is initiated by clicking Playback File on the File menu, which opens a 

dialogue box that prompts the user to select a file to perform the playback on, as shown in 

Figure 60. Note that the files recorded during flight have the extension .sfl. 

 
Figure 60 Open dialogue box associated with the playback mode 

The ScanFish III Flight software will immediately jump to the first record in the log file and 

begin the playback from here at a 1:1 speed. The functions associated with the playback 
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toolbar (Pause/Play, Play Speed and Goto Time) now become active and can be used to 

control the playback. Generally, the functions available during flight mode are also available 

in playback mode. 

Note that a few exceptions to this general rule apply. When in playback mode: 

• It is not possible to change the flight mode 

• As a consequence of this, no alterations can be made to the depth 

requirements in the different modes (normally executed from the Tow 

panel) 

• Settings for Fish and Cable Counter cannot be changed 

• Settings for Logging cannot be changed 

6.5 Configuring the display layout 

The display of the ScanFish III Flight software can be configured to meet the individual 

needs of the users. The ScanFish III Flight software main window consists of a number of 

dockable panels that can be toggled on/off using the View menu, as shown in Figure 61. 

 
Figure 61 Dockable panels 

The panels can float freely inside the ScanFish III Flight software main window. They can be 

docked to the edges of the windows, or they can float onto a secondary screen if one is 

present. When moving a panel and holding it over a position where docking is possible 

(around the edges and in the middle of the main window), a set of arrow markers will 

appear. The user must point to the appropriate arrow and leave the panel there. The 

software will automatically position, align and resize the panel to match the surrounding 

panels. The example in Figure 62 shows the Roll panel being docked below the Pitch 

panel. Selecting the Left/Right arrow will place the panels side by side, and selecting the 

Centre marker will place the panels in the same spot but on different tabs. Dragging a tab 

into another position will turn the tab into a separate panel again. 
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Figure 62 Docking the Roll panel beneath the Pitch panel 

In Figure 63, a typical example of a ScanFish III Flight software display layout is shown. 

 
Figure 63 The ScanFish III Flight software display layout for Follow Seabed mode 

The layout is saved automatically and will be used the next time the ScanFish III Flight 

software is started. 

Information on how to define and configure the layout with the available panels is described 

in Section 6.6 ‘Display panels’. The various panels are described in the order of their listing 

under Views > Dockable Panels. 
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6.6 Display panels 

6.6.1 The Depth Monitor panel 

The Depth Monitor panel, shown in Figure 64, displays a graphical, scrolling time series 

view of the ScanFish III depth, the seabed/bottom depth and the target depth. 

It is possible to export the contents into PDF documents or comma-separated (CSV) files 

from a menu that appears when right-clicking in the Depth Monitor panel. The panel (user 

interface) properties of the Depth Monitor panel can be modified under Settings > Options 

> User Interface > Depth Monitor Panel. 

 

Figure 64 Depth Monitor panel 

6.6.2 The Roll panel 

The Roll panel shown on the left in Figure 65 shows a live 3D model of the ScanFish III as 

well as a numerical roll value (given in degrees). The 360° perimeter of the circle in which 

the 3D model is shown is divided into 10° increments in the example in Figure 65. The red 

marker here indicates the actual reading of the roll value.  

When the size of the panel is made adequately small, the 3D model will disappear, and only 

the numerical value will be displayed (see Figure 65 in the middle).  

The Roll panel will be displayed with a red background in case of extreme behaviour, such 

as when roll is very high or the ScanFish III is upside down (see Figure 65 on the right). 
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Figure 65 Roll panel 

6.6.3 The Pitch panel 

The Pitch panel, shown in Figure 66, is similar to the Roll panel. It shows a live 3D model 

of the ScanFish III as well as a numerical pitch value (given in degrees). The 360° perimeter 

of the circle in which the 3D model is shown is divided into appropriate increments for the 

present resolution/size of panel (5° in the example in Figure 66). The red marker here 

indicates the actual reading of the pitch value. When the size of the panel is made 

adequately small, the 3D model will disappear, and only the numerical value will be 

displayed. 

 

Figure 66 Pitch panel 
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6.6.4 The Tow panel 

The Tow panel, shown in Figure 67, serves a dual purpose. By default, it will display the 

present basic towing-related property settings of the ScanFish III: 

• Set Bottom Margin 

• Set Fixed Depth 

• Set Fixed Height 

• Set Max Depth 

• Set Min Depth 

• Set Minimum Altimeter Depth 

• Set Parking Depth 

• Set Undulate Rate 

These settings can be changed during flight by clicking the relevant property’s field. As a 

result, the selected field will increase in size, and Plus (+) and Minus (-) buttons that 

facilitate alteration of the values will appear (see Figure 67 on the right). Once the value has 

been changed and the user clicks elsewhere, the settings will be applied. Further details on 

the Tow panel properties are given in Table 10. 

  
Figure 67 Tow panel 
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In Table 10, descriptions of the available properties in the Tow panel are given along with 

recommendations for some settings. 

 

Property Description Recommended setting 

Set Bottom Margin 

The minimum height in metres above the 

seabed that the ScanFish III must stay 

above. This is a safety setting, and if the 

ScanFish III should ever find itself closer to 

the seabed than the defined height limit, it 

will automatically rise. 

The defined setting should take into 

consideration the features of the seabed – that 

is, a smaller distance can be used for a seabed 

with smaller variations and/or fewer 

obstructions. 

Set Fixed Depth 

The depth in metres below the water 

surface that the ScanFish III must attempt 

to stay at when in Fixed Depth mode. 

 

Set Fixed Height 

The height in metres above the seabed that 

the ScanFish III must attempt to stay at 

when in Follow Seabed mode. 

 

Set Max Depth 

The maximum depth in metres below the 

water surface that the ScanFish III will 

descend to when in Undulate mode (lower 

limit). 

The defined setting should take into 

consideration the installation (eg the cable 

length). The maximum depth should always be 

considerably less than the cable length. 

Set Min Depth 

The minimum depth in metres below the 

water surface that the ScanFish III will 

ascend to when in Undulate mode (upper 

limit). 

 

Set Minimum 

Altimeter Depth 

The minimum depth in metres below the 

water surface for when the altimeter will be 

used. This is useful if the surface water has 

a lot of turbulence. 

 

Set Parking Depth 

The depth in metres below the water 

surface that the ScanFish III will go to when 

Parking mode is selected (by clicking the 

Parking button in the main window). 

The parking depth should be less than the 

overall depth in the area of sailing. A parking 

depth of 0 m (at the surface) is not 

recommended since this will make it difficult for 

the ScanFish III to dive when this is required. 

Set Undulate Rate 

The ascend/descend speed in metres per 

second at which the undulation is 

performed. 

Note that a steep ascent/descent will generate 

very high drag, and that the ScanFish III can 

pull with a force of up to 10 kN if ordered to 

climb vertically. 

Table 10 Tow panel property settings 
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6.6.5 The Messages History panel 

The Messages History panel, shown in Figure 68, contains status and action messages. 

Note that the messages shown in Figure 68 are related to a playback situation.  

 
Figure 68  Messages History panel  

Information message text is in black. If a warning message is issued, the text will be in 

orange, and if an error message is issued, the text will be in black with a red background, as 

shown in Figure 69. 

 
Figure 69 Messages History panel when an error message is issued  

6.6.6 The Data Chart panel 

The Data Chart panel, shown in Figure 70, can be used to display a number of different 

time series charts in a single panel. By default, the panel is empty, as shown in Figure 70 on 

the left). However, when various data sources are selected, the panel will become 

populated, as shown in Figure 70 on the right. 

  
Figure 70 Data Chart panel at startup (left) and when populated (right) 
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The data sources available for display can be toggled on and off from the menu that 

appears when right-clicking in the panel. The available data sources, given in sequence, 

are: 

• Fish Battery Voltage: Displays the ADC of the ScanFish III 

• Fish Altimeter: Displays the altitude of the ScanFish III 

• Fish Depth: Displays the depth of the ScanFish III 

• Fish Flap Angle Port: Displays the flap angles for port 

• Fish Flap Angle Starboard: Displays the flap angles for starboard  

• Fish Flap Command Port: Displays the command sent to the port flap 

• Fish Flap Command Starboard: Displays the command sent to the starboard flap 

• Fish Heading: Displays the ScanFish III heading 

• Fish Pitch: Displays the ScanFish III pitch 

• Fish Roll: Displays the ScanFish III roll 

• Fish Target Depth: Displays the target depth as defined via the Tow panel 

The Data Chart panel allows the user to dump the present Data Chart charts to a PDF file 

(see Figure 71). Similarly, the data from the Data Chart can be exported to a CSV file that 

allows for further analysis of the data in other software environments, such as 

spreadsheets. These features are available when right-clicking in the Data Chart panel. 

 

Figure 71 Exported PDF file of Data Chart charts 
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6.6.7 The Alert panel 

The Alert panel, shown in Figure 72, shows the current status of the different parts of the 

ScanFish III. When operating normally, all status indicators are displayed with a green 

check mark.  

In Figure 72 on the left, there is an error alert for the Connection to Cable Counter status 

indicator. On the right, the Alert panel is shown with no error alerts. 

  

Figure 72 Alert panel, with and without error alerts 

6.6.8 The Numeric Panel 

The Numeric panel, shown in Figure 73, shows real-time numerical readings of the different 

ScanFish III data measurements. The sequence can be changed by right-clicking a 

measurement, which will open a dialogue box where you can select Move Up or Move 

Down, as shown in Figure 73 on the right. Note that this dialogue box also allows for 

alteration of the text colour.  

 

  
Figure 73 Numeric panel 
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The measurements are predefined and are, to a large extent, similar to the items available 

for graphical display in the Data Chart panel. Only the default sequence differs slightly: 

• Altimeter: Displays the altitude of the ScanFish III 

• Depth: Displays the depth of the ScanFish III 

• Battery Voltage: Displays the ADC of the ScanFish III 

• TargetDepth: Displays the target depth as defined via the Tow panel 

• Roll: Displays the heading of the ScanFish III in a chart 

• Pitch: Displays the pitch of the ScanFish III in a chart 

• Heading: Displays the roll of the ScanFish III in a chart 

• Flap Angle Port: Displays the flap angle for port numerically 

• Flap Angle Stbd: Displays the flap angle for starboard numerically 

• Flap Command Port: Displays the port flap command sent to the ScanFish III  

• Flap Command Stbd: Displays the starboard flap command sent to the ScanFish III 

6.7 Software Interfaces 

As mentioned in Section 6.3.1.3.3 ‘Options’, the Exporters item is divided into two 
subitems: NaviScan and NaviPac. By selecting either NaviScan or NaviPac, the properties 
shown in Figure 74 and Figure 75 will appear in the properties pane on the right side of the 
Options dialogue box. The properties allow for the export of cable counter data as well as 
export of ScanFish III data. 

 
Figure 74 Data export properties for NaviScan 

 

 
Figure 75 Data export properties for NaviPac 
 

Enable Export is related to the Fish Data Export as well as to the Cable Counter Data 
Export. It is a Boolean that has the value ‘False’ by default. 
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6.7.1 Cable Counter data import 

A cable counter can be interfaced with the ScanFish III Flight software for control, display 

and usage of information. When later exported, the software combines the cable length 

information with depth information to estimate the actual layback of the ScanFish III. The 

instrument selection is made under Settings > Options > Winch and Cable Counter > 

Cable Counter > Type. 

 
Figure 76 Cable Counter settings 

 

Format L=(\d+(\.\d*)?)m +\rS=(\d+(\.\d*)?)m/m +\r 

Example L=34.00m <CR>S=12.34m/m <CR> 

Connection type UDP or RS232 

Table 11 MacArtney MKII Cable Counter instrument properties 

 

Format L=(\d+(\.\d*)?)m+\r 

Example L=34.00m<CR> 

Connection type UDP or RS232 

Table 12 MacArtney EdgeTech Cable Counter instrument properties 
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6.7.2 Cable Counter Data Export 

 

Format L=<length>\r 

Example L=123.45<CR> 

Connection type UDP or RS232 

Table 13 Compensated cable out (layback) 

The cable out is compensated for vehicle depth (simple triangle calculation) and thus 

defines the 2D layback information – that is, the lateral distance from the ship to the ROTV. 

The data export can be interfaced with NaviPac via the Generic Cable Counter instrument. 

6.7.3 Fish Data Export 

 

Format $SF,Fish,<heading>,<roll>,<pitch>,<depth>,<altimeter>\r\n 

Example $SF,Fish,12.12,1.13,-4.14,115.25,16.16<CR><LF> 

Connection type UDP or RS232 

Table 14 Export to NaviPac 

The data can be used in NaviPac via generic data input. 

 

Format D<depth> T00.00 R<altimeter>\r\n 

Example D151.15 T00.00 R16.16<CR><LF> 

Connection type UDP or RS232 

Table 15 Export to NaviScan 

The data can be used in NaviScan via the PSA900 instrument. 
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7 ScanFish III Flight software & NaviPac 

integration 

7.1 ScanFish III Flight software settings  

As detailed in Section 6.3.1.3.3 ‘Options’, the Exporters item is divided into two subitems: 
NaviScan Export and NaviPac Export. By selecting NaviPac Export, the properties will 
appear in the properties pane on the right side of the Options dialogue box, as shown in 
Figure 77. The properties allow for the export of cable counter data as well as export of 
ScanFish III data. 

 
Figure 77 Data export properties for NaviPac 

• Cable Counter Data Export allows for the export of cable counter information 

between the ScanFish III Flight software and NaviPac. The exporter supports UDP 

as well as RS-232 (serial) connection types. The default port when using UDP 

interfacing is 8897. Note that the cable out is compensated for vehicle depth 

through a simple triangle calculation that automatically uses the depth sensor 

information and thus defines the 2D layback information. The format of the output is: 

L=<length>\r. Example: L=123.45<CR> 

• Enable Export is related to Fish Data Export as well as to Cable Counter Data 

Export. It is a Boolean that has the value ‘False’ by default. 

• Fish Data Export allows for export of a variety of information that can be logged in 

NaviPac. The exporter supports UDP as well as RS-232 (serial) connection types. 

The default port when using UDP interfacing is 8898. The format of the output is:  

$SF,Fish,<heading>,<roll>,<pitch>,<depth>,<altimeter>\r\n. Example:   

$SF,Fish,12.12,1.13,-4.14,115.25,16.16<CR><LF> 

7.2 NaviPac settings 

The dedicated NaviPac configuration that allows for integration with the ScanFish III Flight 

software is much simpler than what was the case with previous versions of the ScanFish 

Flight software and the ScanFish III itself.  
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7.2.1 Cable counter data 

Within NaviPac, the cable counter information can be used to position the ScanFish III and 

thereby associate the various sensor information with a geographical reference.  

The cable counter information must be interfaced by utilising Generic Cable Counter as a 

dynamic positioning instrument, as shown in Figure 78. 

 
Figure 78 Example of ScanFish III-based cable counter settings in NaviPac 

Important comments regarding the main properties of the Generic Cable Counter 

instrument shown in Figure 78 are as follows: 

• System Name: Read-only. Displays the NaviPac-defined instrument name 

(‘Generic Cable Counter’). 

• I/O: Edit I/O settings. The interface settings in NaviPac must correspond to the 

interface settings in the ScanFish III Flight software (see Section 6.3.1.3.3 ‘Options’ 

for details). Note that the port number is the default port when using an UDP/IP 

interfacing. 
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• Name: Allows for entering a user-defined name for the instrument. The default 

value is the NaviPac-defined system name (‘Generic Cable Counter’); however, any 

name can be entered here.  

• Offset X, Offset Y and Offset Z: Together, these three settings specify the position 

of the sheave/winch from which the ScanFish III is towed in the local coordinate 

system of the vessel. 

• Location: the ScanFish object (see Figure 79) must be selected, because this is 

the object to be positioned with the instrument.  

• String prefix: The instrument supports a series of formats, however the ones 

presently supported by the ScanFish III Flight software (MacArtney_MKII (default) 

and MacArtney_EdgeTech) both require ‘L’ to be the string prefix. 

• Correct layback for SMG: The check box for this property must be cleared, 

because the cable counter data have already been corrected (by default) in the 

ScanFish III Flight software to the horizontal level. 

Prior to actually configuring the Generic Cable Counter instrument, the ScanFish object 

must be configured, as shown in Figure 79. 

 
Figure 79 Definition of the ScanFish object 

Important comments regarding the main properties related to the ScanFish object shown in 

Figure 79 are as follows: 

• Name: Allows for entering a user-defined name for the instrument. The default 

value is ‘NOT DEFINED’. Change the name of this object to ‘ScanFish’.  
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• Gain: NaviPac uses an exponential filter to calculate the speed (SNG) and course 

(CMG) of the object. The value entered defines the smoothness of the filter, with 

values very close to 0 being used to show raw observations and values very close 

to 1 being used to show highly smoothed data. Though a value between 0.8 and 1 

gives the best results under normal conditions, values closer to 0 could be used in 

the present context because of the nature of the position calculation. However, the 

user is encouraged to spend ample time determining the optimum settings for the 

specific configuration. Please note that this has no influence on the position 

calculated, which is still based on the raw observations. 

• Description: Allows for entering a user-defined description of the instrument. This 

field is by default blank. 

• Kalman Filter: The check box for this property must be cleared, because it uses all 

available information to improve the position calculations. This is not relevant in the 

present context, since normally no DVL is available and the motion/gyro is most 

often not of a quality that justifies this kind of usage in NaviPac. 

For the remaining properties, use the default settings, which are shown in Figure 79. 

7.2.2 Interfacing sensors 

Data originating from the dedicated oceanographic instruments mounted on the ScanFish III 

can be logged in NaviPac as ordinary sensors. A wide variety of sensors are available in the 

NaviPac sensor instrument library, so the following two examples have only been included 

in order to illustrate some representative configuration scenarios. 

A typical ScanFish III instrument is interfaced into NaviPac as a data acquisition instrument. 

This is done by right-clicking Data acquisition in the NaviPac Configuration Instruments 

list and then in the menu that appears, clicking Add new item. The dialogue box shown in 

Figure 80 appears and prompts the user to select the data type of the desired instrument.  

In the first example, the user must select Science and Oceanographic (in principle, all 

data acquisition instruments and other instrument types can be interfaced and logged). 

  
Figure 80 Data acquisition selection dialogue box (data type selection) 
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Clicking the Next button in the Data acquisition selection dialogue box opens the Add 

new instrument dialogue, which is shown in Figure 81. This dialogue box lists the 

supported instrument types. When an instrument type has been selected (in the present 

context, AMT Dissolved Oxygen), the dialogue box will appear as shown in in Figure 81 on 

the right. 

   
Figure 81 Science and Oceanographic instrument type list (left) and selection (right) 

Clicking OK in the Add new instrument dialogue box after selecting the AMT Dissolved 

Oxygen instrument type will open the Instrument I/O dialogue box, shown in Figure 82. 

The AMT Dissolved Oxygen instrument is interfaced via an AD converter to a simple 

ASCII string. The first step of the interfacing is shown in Figure 82, in which the user selects 

the various I/O settings. 

 
Figure 82 Instrument I/O dialogue box 
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Some of the instrument’s property settings can only be configured in the Instrument I/O 

dialogue box. Other property settings must be configured later, in the properties pane. Once 

the user accepts the I/O settings by clicking OK in the Instrument I/O dialogue box, 

however, the instrument will appear in the Instruments list and its properties will appear in 

the properties pane, as shown in Figure 83. 

 
Figure 83 AMT Dissolved Oxygen instrument configuration 

The AMT Dissolved Oxygen instrument is interfaced via an AD converter to a simple 

ASCII string. NaviPac stores raw voltage, oxygen percentage and concentration in the three 

channels that are available for each data acquisition instrument. Based on the ASCII string 

received, NaviPac will calculate the oxygen percentage and the concentration using the 

formulas and the calibration constant supplied by the manufacturer, AMT 

(Analysenmesstechnik GmbH). 

In Online mode, NaviPac will perform the conversions and make them available to the user 

in a variety of ways. Figure 84 on the left shows data in the NaviPac Rawdata window. The 

raw data coming in is shown in the Raw Data field in the upper part of the window, whereas 

NaviPac’s interpretation is visualised in the lower part of the window. 
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A more visual way of displaying the instrument data in NaviPac is using the Dataacq 

window, shown in Figure 84 on the right. This window facilitates alphanumerical as well as 

graphical presentation of data acquisition instrument data. The Dataacq window is available 

in NaviPac version 3.9.3 and earlier. 

  
Figure 84 NaviPac Rawdata window (left) and Dataacq window (right) 

The window shown in Figure 85 is the DataMon window, which is available in NaviPac 

version 3.9.4 and later. It is the successor of the Dataacq window and offers the user a 

much higher degree of freedom and flexibility when it comes to designing the visualisation 

windows. The configuration of the DataMon window is shown in Figure 86. 

 
Figure 85 DataMon window with AMT data 
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Figure 86 Configuration of the DataMon window 

The second example is associated with the SBE49 CTD data acquisition instrument, shown 

in Figure 87. This is basically a CTD probe that inputs conductivity, temperature, pressure 

(converted to depth by NaviPac), salinity and sound velocity. The incoming string has the 

format TT.TTTT, CC.CCCC, PPPP.PP,SS.SSSS,VVVV.VVVV<cr><lf>, where T is 

temperature, C is conductivity, P is pressure, S is salinity and V is sound velocity. 

 
Figure 87 SBE49 CTD instrument configuration 
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However, NaviPac only uses the three channels associated with the CTD information. This 

is illustrated in the DataMon window shown in Figure 88, where the three channels are 

shown in an alphanumerical presentation of the NaviPac interpretation in the CTD From 

NaviPac panel. Note that TEL-C, TEL-T and TEL-D are conductivity, temperature and 

depth, respectively. 

 
Figure 88 DataMon window visualising data from the AMT (top) and the CTD sensor 

(bottom) 

In the CTD Generic Sensor panel in the bottom of the DataMon window in Figure 88, 

DataMon shows an interpretation of all the observations coming into the port from the 

sensor. Note that the NaviPac interpretation (CTD from NaviPac) and the DataMon 

interpretation (CTD Generic Sensor) can be shown simultaneously. 

The DataMon interpretation has been achieved by bypassing the NaviPac interfacing and 

interpretation. This can be relatively easily accomplished by setting up the configuration of 

the DataMon window, as shown in Figure 89. 
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Figure 89 Configuration of the DataMon window shown in Figure 88 

Note that the DataMon window is described in details in the associated Help articles as well 

as in the DataMon manual that is available from the Help menu in the DataMon 

configuration window.  

7.2.3 Helmsman’s Display 

In the Helmsman’s Display, a number of views can be used to display information related 

to the ScanFish III. This information is displayed in the views marked in the red rectangle in 

the Helmsman’s Display in Figure 90. For each of the items to be shown in NaviPac 

version 3.9.3 and earlier, a Dynamic Object view must be defined. 
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Figure 90 Data acquisition instrument information shown in Helmsman's Display dynamic 

object views 

In NaviPac version 3.9.4 and later, a more flexible method of visualising data acquisition 

instruments is possible. An example of so-called multiple data acquisition (Multiple DAQ) 

view is shown in Figure 91, where it can be seen that all channels associated with a data 

acquisition instrument can be visualised together in a single view. 

 
Figure 91 Multiple DAQ view in the Helmsman’s Display 
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7.2.4 Data logging 

The LogData window is used to control the standard data logging within NaviPac. The user 

can choose between logging in three different ASCII text formats: 

• General format: A general format that will contain all information including events 

and raw instrument data. 

• Survey format: An XYZ ASCII record format to be read by the dedicated NaviPac 

interpreter in NaviEdit. All position, depth and attitude (gyro, roll, pitch and heave) 

values are logged together with all relevant data acquisition data. 

• Custom format: A format that can be customised by the user based on the 

configuration settings. 

As a general rule, the survey format should be used when the user wishes to log data that 

must be used for further processing and presentation in NaviEdit and other programs. When 

the purpose is to log data that can readily be presented as it is, the custom format should be 

selected. However, generally, the recommendation is to always log in all three formats. 

8 Payload communications 

The payload ports on the ScanFish III with serial communication are connected to a Digi 

PortServer. In order to connect to these ports, the virtual COM ports must be installed on 

the host computer. 

In this case, the host computer is the computer connecting to the COM ports, not 

necessarily the computer running the ScanFish III Flight software. It just needs to be 

connected to the same LAN as the ScanFish III Power & communications. 

For information on the installation of the virtual COM ports on a computer, please see 

Section 8.1 ‘Requirements’ and Section 8.2 ‘Digi PortServer’. 

8.1 Requirements 

• ScanFish III 

• ScanFish III Power & communications  

• Computer 

• Windows 7 

• Ethernet 

• Digi PortServer driver (available from Digi website: 

http://www.digi.com/support/supporttype?type=drivers) 

• Ethernet cable 
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8.2 Digi PortServer 

1. Connect the ScanFish III as described in the user manual 

2. Connect the host computer to the same LAN as the ScanFish III Power & 

communications 

3. Start up the computer, and, in the computer’s network settings, select the following 

specific IP address and subnet mask: 

• IP address:  10.10.103.xxx (insert available IP address) 

• Subnet mask: 255.0.0.0 

 

 

 Figure 92 IPv4 properties for setup of Digi PortServer 

4. Run the Digi PortServer driver setup 

5. The PortServer’s IP addresses are: 

• Primary:  10.10.103.101 

• Secondary (optional): 10.10.103.102  

6. Install designated payload sensor software 

It is recommended to check for updates from Digi and install the newest drivers for the 

model PortServer TS 4 MEI here: 

http://www.digi.com/support/supporttype?type=drivers 

After the Digi configuration, make sure you have the ports available in Device Manager 

under Control Panel, and find out which COM port numbers on the computer have been 

assigned to each payload port. 
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8.3 Advantech ADAM module (optional) 

The ADAM module is set up with the IP address ‘10.10.103.103’. 

To see data, use Advantech software, EIVA NaviPac or other designated third-party 

software. 

9 Procedures for use of the ScanFish III 

9.1 Pre-flight 

This section describes the procedure that must be followed before each deployment. This 

consists of both software checks and visual inspection. The purpose of the pre-flight check 

is to ensure that the ScanFish III is ready for deployment. Never deploy without completing 

a successful pre-flight check.   

Never perform a pre-flight check while the ScanFish III is deployed in the water. The pre-

flight check must always be performed with the ScanFish III on deck (or for the ScanFish 

Tropheus only, in the cradle). 

1. Make sure that the ScanFish III flaps are free of any obstructions, and inform 

relevant personnel of the upcoming pre-flight check. Caution: Never touch the 

flaps while the ScanFish III system is turned on due to the risk of personnel 

injury. The flaps are very strong and may not stop if obstructed by a 

hand/finger. 

2. Visually check for signs of oil leakage around the flaps. If there are signs of oil, 

replace the flap motor. Do not use a leaking flap motor. 

3. Visually check for signs of cracks in the ScanFish III outer shells and skeleton. Do 

not deploy if any cracks are discovered in either the shells or the skeleton. 

4. Check all outer screws, and tighten them if loose. 

5. For the ScanFish Tropheus only – Check the cotter pin (split pin) and locking ring 

in the foldable tow arm. Do not proceed if either one is corroded, broken or missing. 

 

 Figure 93 Cotter pin (left) and locking ring (right) 
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6. Check shackles – they must all be fastened securely.   

7. Turn on the ScanFish III Power & communications and start the ScanFish III Flight 

software.4 

8. Select Pre Flight Check mode in the ScanFish III Flight software. 

9. Visually check that both flaps are moving to their extreme positions (up and down) 

and back again to the initial position. 

10. In Pre Flight Check mode, the ScanFish III Flight software will check the ScanFish 

III system and all ScanFish III sensors. Alert statuses will be presented in the 

ScanFish III Flight software – green check marks for passed checks and red 

crosses for failed checks. The background will also flash red in the Alert panel in 

case of a failed check. Do not proceed if ScanFish III Flight software reports any 

failed checks. 

• In case of a failed check, the error must be corrected, and the ScanFish III 

Flight software pre-flight check in Pre Flight Check mode must be repeated 

from the beginning. 

• If the ScanFish III Flight software pre-flight check in Pre Flight Check mode 

is successful, you can proceed with deployment of the ScanFish III. 

11. Make sure the pressure sensor reading has reset to approximately ‘0.00’ when the 

ScanFish III is above water. 

12. Note that The ScanFish III has an internal battery backup system that keeps the 

battery charged during normal operation. If the ScanFish III has been used in 

System Failure mode due to a power supply failure and/or communications failure 

during deployment, or if the ScanFish III has not been used for several months, the 

battery may be discharged. Please allow the ScanFish III to charge the battery for 

two to three hours before deployment. Important: Charging must be done with the 

ScanFish III turned on and submerged in water in order to prevent overheating.  

13. Ensure that the ScanFish III is not turned on for more than 20 minutes while on 

deck. The ScanFish III will overheat if used without the cooling effect of the water. 

In warm and sunny weather (25ºC and above), this time limit should be reduced to 

about 10 minutes. 

14. In the ScanFish III Flight software, set the desired parking depth parameter. Ensure 

that the chosen parking depth is less than the overall depth in the area of sailing in 

order to minimise the risk of the ScanFish III crashing into the seabed. A parking 

depth of 2 metres is recommended and normally safe.  

  

                                                      
4 See Section 5.3 ‘Connecting to the ScanFish III’ for detailed instructions on how to do this. 
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9.2 Deployment of the ScanFish III 

This section describes the procedure that must be followed in order to ensure successful 

deployment of the ScanFish III. Deployment must be performed immediately following a 

successful pre-flight check. Do not rely on a pre-flight check performed hours ago – in that 

case, you must complete a new successful pre-flight check before deployment. Do not 

deploy the ScanFish III in icy water, and avoid sailing through water containing debris or 

objects that could harm the ScanFish III in the case of a collision or by getting caught up in 

the system, as this may damage the ScanFish III and the tow cable. Make sure that both 

hatches are securely fastened. Never deploy without hatches or with screws missing. 

Always act responsibly and stay focused on safety. 

1. Make sure the ScanFish III is in On Deck mode. 

2. Keep vessel speed between 2 to 3 knots. 

3. Lift the ScanFish III up from the deck (or for the ScanFish Tropheus only, from the 

cradle) by winding up the cable and/or by using the A-beam. 

4. Deploy the ScanFish III carefully by winding out cable and/or using the A-beam. 

5. Make sure that the ScanFish III is positioned correctly when deployed into the 

water.   

6. When the ScanFish III touches the water surface, change the flight mode to Surface 

mode. 

7. Increase the vessel speed to 4 knots while slowly winding out the cable. Very fast 

winding may result in the ScanFish III having no speed through the water and 

therefore being out of control. Increase vessel speed to keep the ScanFish III in 

control if spooling out very quickly.  

8. Set the ScanFish III to Parking mode. The purpose of Parking mode is to place the 

ScanFish III at a safe depth and still have full dynamic control. Always choose 

Parking mode when the ScanFish III is idle or not collecting data. 

9. Release adequate cable length needed for the planned survey operation. 

10. Keep the vessel speed between 4 to 10 knots while in operation. 

9.3 While operating 

This section describes how to operate the ScanFish III, and it discusses precautions for the 

use of ScanFish III. Please ensure that recommendations and precautions are followed in 

order to ensure safe operation. 

• Sudden changes in vessel speed and/or direction may temporarily influence the 

performance of the ScanFish III because the dynamics of the water change. The 

ScanFish III will adapt to the new conditions in less than a minute, and performance 

will restored to normal. Do not make sharp turns with the vessel if the ScanFish III is 

within a few metres from the seabed – the ScanFish III will lose speed, and this 

could cause a fatal crash with the seabed. If sharp turns are necessary, set the 
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ScanFish III to Parking mode and wind up the some cable before turning. After 

turning the vessel, wind out the cable and select the desired flight mode in the 

ScanFish III Flight software.  

• Sudden changes in cable length due to winding out/up may temporarily influence 

the performance of the ScanFish III because the dynamics of the water change. The 

ScanFish III will adapt to the new conditions in less than a minute, and performance 

will be restored to normal. 

• Always ensure that the ScanFish III’s height above seabed is at a safe level, based 

on the features of the seabed. If the height is very low and the seabed has steep 

slopes or large objects in the path of the ScanFish III, the risk of collision is high. 

• The ScanFish III has a bottom anti-collision feature that will force the ScanFish III to 

ascend quickly if the height gets below the defined limit. Important: Do not use this 

feature to keep a very low height above the seabed – it is an emergency feature for 

avoiding collisions. Combinations of low height, high/low vessel speed and steep 

slopes/large objects on the seabed may still result in fatal collision. 

• Make sure that the ScanFish III Flight software is monitored at all times while 

operating the ScanFish III – sudden changes in roll or pitch of the ScanFish III may 

require immediate attention and possibly also immediate recovery.  

• In case of problems keeping the roll between -2° and 2°, vessel speed should be 

immediately lowered, the flight mode should be changed to Surface mode, the cable 

should be wound up and the ScanFish III should be recovered as quickly as 

possible. 

• If the ScanFish III experiences a power supply failure, it will switch to internal 

battery backup and begin ascent to the surface. This will generate an alert. Recover 

the ScanFish III immediately. 

• If the ScanFish III Flight software experiences a communications failure with the 

ScanFish III, it will generate an alert. At the same time, the ScanFish III will enter 

into System Failure mode and begin ascent to the surface, powered by either the 

ScanFish III Power & communications or the internal battery. Recover the ScanFish 

III immediately. Allow the ScanFish III to charge for two to three hours before the 

next pre-flight check and deployment. Important: During this charging period, the 

ScanFish III must be turned on and submerged in water in order to prevent 

overheating.  

• If the altimeter is blocked by an object hanging under the ScanFish (eg an external 

sonar system), the ScanFish III will assume that the seabed is rising with a 

predetermined slope. This will result in the ScanFish III ascending slowly to the 

surface. If the object is removed, the ScanFish III will resume normal operation. 

• Pre-flight check, deployment and operation of the ScanFish III with a discharged 

backup battery is possible, but this is done so at your own risk and is not 

recommended. A discharged backup battery will charge during the first two to three 

hours of normal operation, but it is strongly recommended to charge the battery 

before use. In case of a power failure with a discharged backup battery, the 

ScanFish III will not ascend to the surface and may collide with the seabed.  
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9.4 Depth vs. cable length and speed 

The ScanFish III is able to operate and keep itself at any depth within the range specified in 

Table 4 in Section 4.1 ‘Technical overview’. In order to do this effectively, a sufficient 

amount of cable has to be wound out in accordance with depth and speed requirements. 

Examples of required cable length are displayed in the chart in Figure 94. 

 
Figure 94 Depth vs. cable length – type of cable A302799 (11.43 mm) 

Caution: The data in the chart in Figure 94 are estimated guidelines and as such are 

affected by sea conditions, specific payload configuration and tow cable 

configuration. These guidelines are to be used with caution until verified by actual 

sea trials.  
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9.5 Recovery procedure 

This section describes the procedure that must be followed in order to ensure successful 

recovery of the ScanFish III. Always act responsibly and stay focused on safety. 

1. Set the ScanFish III to Parking mode.  

2. Set the vessel speed to approximately 4 knots, and wind up the cable. Winding up 

the cable when the vessel is travelling at a high speed can cause the actual speed 

of the ScanFish III through the water to exceed 10 knots. Avoid this by reducing the 

vessel speed to be in accordance with the winding speed. 

3. When the ScanFish III is between 20 to 50 metres behind the vessel, set the 

ScanFish III to Surface mode and wait until the ScanFish III reaches the surface. 

4. Recover the ScanFish III by winding up the cable and/or using the A-beam. 

5. When the ScanFish III leaves the water, change the flight mode to On Deck mode. 

This will stop movement of the flaps and disconnect the internal battery. 

6. Rinse the ScanFish III with fresh water on the outside and the inside through the 

openings around the tow point. Make sure that all internal parts are rinsed with fresh 

water. Hatches may be opened in order to rinse the internal parts properly. 

7. Protect the ScanFish III from direct sunlight, excessive heat and icy conditions with 

a reflective cover when stored on the deck. 

9.6 Storing of the ScanFish III 

When not in use, the ScanFish III needs to be stored properly. Do not store the ScanFish III 

resting on its shells or on sharp edges in general. Take care that The ScanFish III is always 

thoroughly supported to minimise static stress on the structure. 

• The cradle should be used for short-term storage (eg between daily operations) of 

the ScanFish Tropheus. Always use the straps to firmly secure the ScanFish III to 

the cradle to prevent it from falling down or being picked up by strong winds and/or 

water. Alternatively, the case can be used for short-term storage of the ScanFish 

Tropheus. 

• The case can be used for short-term storage of the ScanFish Rocio, the ScanFish 

Katria and the ScanFish Konia. 

• The case should be used for long-term storage – ensure that the ScanFish III is dry 

before long-term storage. 

• If not being stored in the cradle or case, ensure that the ScanFish III rests on its 

side panels with the tow point facing upwards and tail facing downwards. Secure 

the ScanFish III firmly to prevent it from tilting. 

• Do not store the ScanFish III for long periods on deck or in wet/moist conditions. 
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9.7 Inspection and maintenance 

Frequent inspection of the ScanFish III is important in order to prevent failures, fatal crashes 

and/or personal injury. The recommended frequency of inspection depends on the amount 

of use and the conditions of use. The more severe the conditions and the more frequent the 

use, the more frequently inspection should be performed. 

• Frequently check that the side guards are securely fastened to the POM side 

panels. Do not use the ScanFish III if the side guards are loose or broken. 

• Frequently check the tow point, including the spindle and safety clip, for wear. Do 

not use the ScanFish III if any parts are bent, broken or worn. 

• Frequently check cables and connectors. If connector pins exhibit signs of 

corrosion, they must be replaced. If cables are cracked or worn, they must be 

replaced.  

• Spray the connectors with thin silicone oil whenever they are unplugged and before 

storage. 

• Spray the connectors again with thin silicone oil before re-connecting. 

• Frequently check shackles for wear. Ensure that they are all firmly secured. 

• For the ScanFish Tropheus only – Frequently check the locking ring and cotter 

pin in the foldable tow arm. If corroded, broken or missing, please replace 

immediately. These are spare parts. Never remount the same cotter pin – once 

dismounted, the cotter pin must be discarded and replaced. 

 

Figure 95 Cotter pin (left) and locking ring (right) 

• The ScanFish III outer shells are made of very robust polycarbonate. Review 

Chapter 10 ‘Polycarbonate chemical resistance’ for an overview of the resistance of 

polycarbonate to specific chemicals. If the outer shells have been exposed to and 

damaged by a chemical, they must be replaced before use. The outer shells are not 

standard spare parts and must be ordered from EIVA. 
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9.8 Calibration of the ScanFish III Controller 

Caution: Before starting this procedure, contact EIVA ScanFish Support for access to 

the internal firmware setup. Changes in the internal firmware can result in unstable 

and fatal behaviour. Unsupervised changes are done at your own risk.  

In order to calibrate the motion sensor in the ScanFish III Controller, the following procedure 

must be followed. This involves moving the ScanFish III around and setting calibration 

values. These values can change depending on configuration and location; therefore, they 

cannot simply be copied from one ScanFish III system to another. 

It is important that this calibration takes places on land, as the sensors need to be at 

complete rest when they are calibrated. 

 
Figure 96 The ScanFish III browser interface - Calibration page 

1. Connect the ScanFish III to the ScanFish III Power & communications and power 

up. 

2. In the ScanFish III browser interface, click Calibration. 

3. Lay the ScanFish III down, resting on its side panels with hatches facing up. 

4. Turn the ScanFish III to face north – wait 30 seconds – click Use Values for 

Heading North.  

5. Turn the ScanFish III to face south – wait 30 seconds – click Use Values for 

Heading South. 

6. Turn the ScanFish III to face east – wait 30 seconds – click Use Values for Heading 

East. 

7. Stand the ScanFish III on its left side – wait 30 seconds – click Use Values for 

Standing on PORT. 

8. Stand the ScanFish III on its right side – wait 30 seconds – click Use Values for 

Standing on STBT. 
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9. Stand the ScanFish III with the tow point facing up – wait 30 seconds – click Use 

Values for Standing on End. 

10. Lay the ScanFish III on its back, hatches facing down – wait 30 seconds – click Use 

Values for Laying on back. 

11. Flip the ScanFish around to the starting position, with hatches facing up. Launch the 

ScanFish III Flight software and connect to the ScanFish III. 

12. Verify that roll and pitch values are close to ‘0’. 

13. Lift the ScanFish III from all angles and verify consistency with the roll and pitch 

panels ( Figure 97, bottom left). 

 

 

 Figure 97 The ScanFish III Flight software 

14. In the ScanFish III browser interface under Factory Setup, set the Done value to 

‘True’. 

15. Restart the ScanFish III and verify that the ScanFish III Flight software still works. 
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10 Polycarbonate chemical resistance 

The ScanFish III shells are made of Acryl, whose resistance to different reagents varies. 

Therefore it is very important to be careful and review the list in Table 16 before exposing 

the shells to chemicals and/or cleaning agents. 

Caution: The information in Table 16 has been supplied to EIVA by reputable sources 

but is to be used only as a guide. Before application, test the reagent on a spare part 

or on a hidden spot of the shell. Ratings of chemical resistance listed in this table 

apply at the specified exposure periods and temperature. EIVA has no knowledge of 

possible effects beyond this. EIVA neither warrants (neither expressly nor implied) 

that the information in this chart is accurate or complete nor that any reagent is 

suitable for any purpose. 

 

Reagent 

  

Polycarbonate temperature 
20°C                                   50°C 

Acetaldehyde S N 

Acetone N N 

Acetic acid E B 

Aluminium hydroxide S N 

Ammonium chloride E E 

Ammonium hydroxide 5% S N 

Ammonium hydroxide 28% N N 

Amyl chloride N N 

Aniline S N 

Benzaldehyde S N 

Benzene N N 

Boric acid E E 

Bromine S N 

Bromoform N N 

Butadiene N N 

Butyl acetate N N 

Butyl alcohol B S 

Butyric acid S N 

Calcium hydroxide N N 

Calcium hypochlorite S N 

Carbon disulphide N N 
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Reagent 

  

Polycarbonate temperature 
20°C                                   50°C 

Carbon tetrachloride N N 

Cellosolve S N 

Chlorine in air E B 

Chlorine (moist) B S 

Chloroform N N 

Citric acid E E 

Cresol N N 

Cyclohexane E B 

p-Dichlorobenzene N N 

Diethylene glycol B S 

Diethylene formamide N N 

Dioxane B S 

Ethyl acetate N N 

Ethyl alcohol E B 

Ethyl chloride N N 

Ethyl ether N N 

Ethylene chloride N N 

Ethylene oxide S N 

Formaldehyde E B 

Formic acid E S 

Gasoline S S 

Hexane N N 

Hydrochloric acid 35% N N 

Hydrofluoric acid N N 

Hydrogen peroxide E E 

Kerosene B S 

Lactic acid E B 

Methyl alcohol B S 

Methyl ethyl ketone N N 

Methyl isobutyl ketone N N 

Methylene chloride N N 

Mineral oil E B 
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Reagent 

  

Polycarbonate temperature 
20°C                                   50°C 

Nitric acid 1-10% E B 

Nitric acid 50% B S 

Nitric acid 65% S N 

Nitrobenzene N N 

Perchloric acid N N 

Petroleum ether S N 

Phenol E N 

Phosphoric acid 85% E B 

Potassium bichromate E B 

Potassium hydroxide conc. N N 

Potassium permanganate E B 

Propane S N 

Propylene glycol S N 

Silver nitrate B S 

Sodium hydroxide conc. S S 

Sodium hypochlorite N N 

Sulfuric acid 20% B S 

Sulfuric acid 98% E B 

Tetrahydrofuran N N 

Thionyl chloride N N 

Toluene N N 

Trichloroacetic acid S N 

sim-Trichloroethane N N 

Trichloroethylene N N 

Turpentine S N 

Urea N N 

Xylene N N 

Table 16 Polycarbonate chemical resistance 

E = Excellent resistance, no etching  

B = Good resistance, little etching after 30 days’ exposure to chemical 

S = Fair resistance, etching after 7 days’ exposure to chemical 

N = Not recommended 
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11 Failure diagnostics 

This section describes a variety of failures and provides information on how to correct 

failures found either during visual inspection, during the ScanFish III Flight software pre-

flight check in Pre Flight Check mode, or during normal operation. The descriptions of 

methods to correct failures are general and may not cover all failure situations. If in doubt, 

please contact the supplier for further details and recommendations. The ScanFish III may 

need to be sent in for repair. 

11.1 Visual inspection shows that the flap motor is 

leaking oil 

1. The flap motor needs to be replaced before use. Do not use a leaking flap motor, as 

this may cause the motor to stop responding without warning while the ScanFish III 

is deployed, leading to a high risk of a fatal crash into the seabed. A deployed 

ScanFish III that is out of control due to failing flaps may cause the tow 

cable/connection to break and/or serious damage to the ScanFish III itself. 

11.2 Visual inspection shows cracks in the outer shells 

and/or skeleton 

1. Do not deploy the ScanFish III if the outer shells and/or skeleton have cracks or are 

damaged. 

2. Parts of the skeleton and/or shells can be replaced when needed. 

3. If the ScanFish III is severely damaged (eg due to being dropped or by crashing 

hard into the seabed), the entire skeleton and shells should be replaced. 

11.3 Visual inspection shows missing paint spots on the 

inside of the shells 

1. This has no functional effect and can easily be repaired with touch-up paint. Please 

consider the chemical resistance of polycarbonate to ensure that any touch-up paint 

is compatible. 

2. Be careful not to scratch the inner surface of the shells in order to prevent paint 

from being damaged. 
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11.4 Visual inspection shows missing/broken oval screw 

supports on the hatches 

1. Replace the missing or broken oval screw supports with spare parts. 

2. Do not deploy the ScanFish III with missing or broken oval screw supports. 

 

 

 Figure 98 Oval screw support 

11.5 Pre-flight check reports a failure in the flap motor 

(port/starboard) 

1. Inspect the flap motor cable at the controller – check that the pins in the connectors 

are clean and do not show signs of corrosion. If no problems are spotted during the 

visual check of the connectors, spray them with thin silicone oil and reconnect. 

2. Check the cable for wear – if damaged, the cable must be replaced. See Section 

12.4 ‘Replacing a flap cable’ for information on replacing cables. 

3. If the cable looks to be in good condition but the pre-flight check still reports a 

failure, the flap motor may be damaged and must be replaced. See Section 12.3 

‘Replacing a flap’ for information on replacing flaps. 

4. Run a new pre-flight check without fastening the new flap motor yet – this test can 

be performed without exchanging the black POM flaps. The rod in the end of the 

flap motor should turn and return to middle position, and the pre-flight check should 

no longer report an error alert for ‘Port/Stbd Flap Status’. If this is the case, the 

problem is solved. The new flap motor needs to be fastened, and the ScanFish III 

needs to be assembled before a final pre-flight check is performed to confirm that 

the new system is ready. 

5. If the pre-flight check still reports a failure in the new flap, the cable must be 

replaced. See Section 12.4 ‘Replacing a flap cable’ for information on replacing 

cables. After replacing the cable, perform new pre-flight checks with both the 

original and the new flap motor to diagnose whether the flap motors themselves 

actually have a failure. 

6. If the pre-flight check still reports a failure with both the original and the new flap 

motor and the cable has been replaced, the controller has an internal failure and 

must be replaced. See Section 12.6 ‘Replacing the controller’ for information on 

replacing the controller.  
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11.6 Pre-flight check reports a failure in the depth 

sensor 

1. Check the cable that connects the depth sensor to the controller. Check that the 

pins in the connectors are clean and do not show signs of corrosion. If no problems 

are spotted during the visual check of the connectors, spray them with thin silicone 

oil and reconnect.  

2. Check the cable for wear – if damaged, the depth sensor and cable must be 

replaced. See Section 12.5 ‘Replacing the depth sensor’ for information on 

replacing the depth sensor. The depth sensor is not a standard spare part and 

needs to be ordered from EIVA. 

3. If the pre-flight check still reports a failure, the controller must be replaced due to an 

internal failure. See Section 12.6 ‘Replacing the controller’ for information on 

replacing the controller. 

11.7 Pre-flight check reports a failure in the motion 

sensor 

1. The motion sensor is an internal part of the controller; therefore, the controller must 

be replaced due to an internal failure. See Section 12.6 ‘Replacing the controller’ for 

information on replacing the controller. 

11.8 Pre-flight check reports a failure in the temperature 

sensor status 

1. If the temperature is too high, turn off the ScanFish III for a few hours and/or 

submerge the ScanFish III in water to cool down the controller quickly. This will 

normally solve the problem. 

2. If the problem is not solved by turning off the ScanFish III or by submerging the 

ScanFish III in water, the controller must be replaced due to an internal failure. See 

Section 12.6 ‘Replacing the controller’ for information on replacing the controller.  

11.9 Pre-flight check reports a failure in the I/O module 

The controller must be replaced due to an internal failure. See Section 12.6 ‘Replacing the 

controller’ for information on replacing the controller. 
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11.10 Pre-flight check reports a failure in the battery 

sensor 

1. The internal battery may be discharged too much. Allow the ScanFish III to charge 

for a few hours. Important: during this charging period, the ScanFish III must be 

turned on and submerged in water in order to prevent overheating.  

2. If charging does not solve the problem, the controller must be replaced due to an 

internal failure. See Section 12.6 ‘Replacing the controller’ for information on 

replacing the controller.  

11.11 Pre-flight check reports a failure in the altimeter 

1. Check the cable that connects the altimeter to the controller. Check that the pins in 

the connectors are clean and do not show signs of corrosion. If no problems are 

spotted during the visual check of the connectors, spray them with thin silicone oil 

and reconnect.  

2. Check the cable for wear – if damaged, the cable must be replaced. See Section 

12.4 ‘Replacing a flap cable’ for information on replacing cables. 

3. If the pre-flight check still reports a failure, the altimeter must be replaced. See 

Section 12.7 ‘Replacing the altimeter’ for information on replacing the altimeter. 

4. If replacing the altimeter does not solve the problem, the controller must be 

replaced due to an internal failure. See Section 12.6 ‘Replacing the controller’ for 

information on replacing the controller. 

11.12 While operating, the ScanFish III cannot reach 

the desired depth and/or cannot keep within the 

defined depth tolerance 

1. Ensure that the cable length is adjusted for the actual operation – too short a length 

of cable makes the ScanFish III sensitive to the movements of the vessel in high 

waves due to the vessel pulling on the cable. Wind out more cable. 

2. The flaps may be obstructed or defective. Recover the ScanFish III and perform a 

pre-flight check. 
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11.13 While operating, the ScanFish III keeps 

undulating a few metres up and down when in 

Fixed depth / Follow seabed mode 

1. Ensure that the cable length is adjusted for the actual operation – too short a length 

of cable makes the ScanFish III sensitive to the movements of the vessel in high 

waves due to the vessel pulling on the cable. Wind out more cable. 

2. Ensure that the altimeter is not obstructed – if the ScanFish III is towing a side-scan 

sonar – that is, it is a ScanFish III Tropheus – make sure that the correct tow arm is 

used. 

3. One or both flaps may be defective. See Section 11.15 ‘While operating, the 

ScanFish III cannot keep the roll between -2° and 2°’. 

4. Check for excessive water flow in front of the flaps. Check for the presence of the 

sealing rubber and metal bar behind both flaps. If missing, the ScanFish III cannot 

control the water flow – do not use the ScanFish III if either of these parts are 

missing or broken. 

11.14 While operating, the ScanFish III Flight software 

reports connection and/or power problems 

1. Recover the ScanFish III immediately. Check the cable and connectors for wear 

and corrosion. Check that the pins in the connectors are clean and do not show 

signs of corrosion. If no problems are spotted during the visual check of the 

connectors, spray them with thin silicone oil and reconnect. 

2. Check the ScanFish III Power & communications – check the cables and 

connectors for wear and corrosion. Replace fuses if any are broken. 

3. Check the slip rings in the winch for wear. Replace any broken or worn down slip 

rings. 

4. If none of the previous steps solve the problem, the controller must be replaced due 

to an internal failure. See Section 12.6 ‘Replacing the controller’ for information on 

replacing the controller. 
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11.15 While operating, the ScanFish III cannot keep 

the roll between -2° and 2° 

1. Recover the ScanFish III immediately. Check the cable and connectors for wear 

and corrosion. Check that the pins in the connectors are clean and do not show 

signs of corrosion. If no problems are spotted during the visual check of the 

connectors, spray them with thin silicone oil and reconnect. 

2. One or both flaps may be defective. Perform a pre-flight check. Check for excessive 

play of the flaps while the ScanFish III is powered. The flaps should be firm and not 

having excessive play. Caution: Be careful not to obstruct the flaps with hands 

or fingers. Safety comes first. 

 

 

 Figure 99 ScanFish III flap play check 

3. Check for the presence of the sealing rubber and metal bar behind both flaps. If 

missing, the ScanFish III cannot control the water flow – do not use the ScanFish III 

if either of these parts is missing or broken. 

 

  

Check for excessive 
play when powered.  
Take care not to 
obstruct the flaps.  

Safety first! 
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11.16 Visual inspection shows that the locking ring or 

cotter pin in the foldable tow arm is 

corroded/broken/missing (ScanFish Tropheus 

only) 

1. Do not deploy the ScanFish Tropheus with a corroded, broken or missing locking 

ring or cotter pin, as the foldable tow arm may fall apart. 

2. Even if only one of the parts is corroded, missing or broken, you should always 

replace both the locking ring and the cotter pin. Never reuse the cotter pin. See 

Section 12.8 ‘Replacing the locking ring and cotter pin in the foldable tow arm 

(ScanFish Tropheus only)’ for information on replacing the locking ring and cotter 

pin.  

11.17 While operating, the ScanFish III keeps seeking 

to the surface (ScanFish Tropheus only) 

1. The view of the altimeter may be blocked by an object. The object could be an 

external sensor mounted under the ScanFish III that is obstructing the built-in 

altimeter. Ensure that any external sensors are secured out of the way of the 

altimeter.  

2. Ensure that the position of the tow arm is correct. 

 

Figure 100 The ScanFish Tropheus with foldable tow arm 

3. If none of the previous steps solve the problem, the altimeter may be defective, and 

the altimeter should be replaced. See Section 12.7 ‘Replacing the altimeter’ for 

information on replacing the altimeter.  

Correct position of the tow arm 

on the ScanFish Tropheus 



 

 

Page 94 of 105 

12 Repair 

This section describes the procedures to be followed when attempting to correct failures 

found during visual inspection, during the pre-flight check or during normal operation.  

Important: If in doubt, do not proceed with repair and instead contact EIVA for further 

advice. Repair of the ScanFish III requires technically-skilled personnel and appropriate 

tools and parts. 

Some of the repairs to the ScanFish III require removal and refitting of one or both POM 

side panels in order to access the components that need replacing. 

12.1 Removal of POM side panels 

1. First, place the ScanFish III on a flat surface – protect the ScanFish III from getting 

scratched. 

 

 

 Figure 101 ScanFish III POM side panel 

2. Identify the black POM side panel to be removed. 

3. Place a supporting beam (preferably made of a soft material, such as wood, so as 

not to scratch the shells) under the ScanFish III shells so that the ScanFish III is 

supported when the side panel is removed. This will prevent excessive strain on the 

body during removal of the POM side panel.  

4. Unscrew the side guard. 

5. Unscrew the POM side panel. Important: On the side where the depth sensor is 

located, make sure that the side panel is not removed completely until the depth 

sensor has been loosened from the side panel. To loosen the depth sensor, feed 

cable from inside the ScanFish III and slowly separate the side panel from the shell. 

Then, loosen the depth sensor bracket on the inside of the side panel. 
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6. Note: Removing the two screws inside the red circle shown in Figure 102 loosens a 

bracket inside the ScanFish III. Keep the bracket, as it must be remounted later.  

 

7. Make sure that the flaps are supported when the POM side panel is being removed. 

8. Repeat steps 1–7 for removal of the other side panel if needed. 

12.2 Refitting of POM side panels 

1. On the side where the depth sensor is located, remount the depth sensor in the 

POM side panel – pull the depth sensor cable from the inside of the ScanFish III 

while refitting the side panel to prevent the depth sensor cable from getting bent or 

damaged.  

2. Screw on the side panel. Important: If the screws seem harder to turn than normal, 

immediately unscrew them and replace with new screws to avoid them getting 

stuck. Use oil on the screws to ensure a smooth insertion. Remember to remount 

the bracket on the inside of the ScanFish III. Do not over-tighten the screws.  

  
 Figure 103 Internal side bracket 
  

Figure 102 Internal side bracket 
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3. Make sure that the flaps are not obstructed by the side panels. 

4. Make sure that the depth sensor cable is not resting up against any sharp edges of 

the skeleton. Use cable fasteners to secure the depth sensor cable if needed. 

5. Screw on the side guard. Do not over-tighten. 

6. Position the ScanFish III on deck (or for the ScanFish Tropheus only, in the cradle). 

7. Perform a pre-flight check to ensure that the system is fully functional. 

12.3 Replacing a flap 

 
Figure 104 ScanFish III flap motor without POM flap parts (left) and with POM flap parts 

(right) 

Important: Never disassemble the flap motor. It is a non-serviceable unit filled with special 

oil. Always use a new spare part and send in the failing unit for repair at EIVA. Only the 

POM flap parts may be removed and refitted to the new flap motor. 

1. Remove the POM side panel on the side of the flap to be removed. 

2. The flap can now be pulled out of the body – make sure that the cable is fed by 

pushing from the inside of the ScanFish III. 

3. When the connector and cable are visible, unplug the cable from the flap. Perform a 

visual check for signs of wear or corrosion. If corroded or if the cable must be 

replaced, this is the time to do it. Important: If the cable must be replaced, remove 

the spiral protection from the old cable and mount on the new cable. 

4. Remove the black POM flap parts – unscrew the screws in the POM flap parts. The 

POM flap parts are not spare parts and should be reused unless damaged. 

 Figure 105 ScanFish III flap motor with one of two POM flap parts removed 
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5. Mount the POM flap parts on the new flap motor – take care not to over-tighten the 

screws in the POM flap parts. If damaged, new POM flap parts must be ordered 

from EIVA. 

6. Check that the pins in the connectors are clean and do not show signs of corrosion. 

7. If no corrosion is found, spray the connectors with thin silicone oil and reconnect the 

cable to the flap. 

8. Pull the cable from the inside of the ScanFish III and push the flap into the body to 

prevent the cable from getting bent when inserting the flap. 

9. Refit the POM side panel.  

10. Position the ScanFish III on deck (or for the ScanFish Tropheus only, in the cradle). 

11. Perform a pre-flight check to ensure that the system is fully functional. 

12.4 Replacing a flap cable 

1. Follow the ‘Replacing a flap’ procedure steps 1–3. 

2. Replace the cable – remember to reuse the spiral protection from the old cable for 

the new cable. 

3. Follow the ‘Replacing a flap’ procedure steps 6–11. 

12.5 Replacing the depth sensor 

The depth sensor is mounted in the POM side panel and cannot be disconnected from the 

cable. Do not try to disassemble – there are no serviceable parts inside. Please note that a 

depth sensor is not included as part of the standard spare part kit.  

1. Unplug the depth sensor cable from the controller. 

2. Remove the POM side panel. 

3. Replace the depth sensor. 

4. Check the cable for wear. If damaged, the cable must be replaced.  

5. Check that the pins in the connectors are clean and do not show signs of corrosion. 

If no problems are spotted during the visual check of the connectors, spray them 

with thin silicone oil and reconnect. Refit the POM side panel. 

6. Position the ScanFish III on deck (or for the ScanFish Tropheus only, in the cradle). 

7. Perform a pre-flight check to ensure that the system is fully functional. 

 

 

 Figure 106 Depth sensor 
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12.6 Replacing the controller 

 
Figure 107 The ScanFish III seen from above, illustrating the correct way to remove the 

controller 

Important: Only remove and insert the controller in the direction illustrated in Figure 107 – 

do not bend or loosen parts in the skeleton. 

The controller is located in the middle of the ScanFish III. It is removed through the side 

hatches in the POM side panels. Do not try to remove the controller through the hatch-

opening by bending the skeleton. This will damage the structure of the skeleton.  

Important: Never disassemble the controller. It is a pressure-tested container, and the 

warranty will be void if disassembled. Please use a new spare controller and send the faulty 

controller to EIVA for repair. Please note that you will need to configure a new IP address 

for the new controller. 

1. Remove both side hatches in order to access the controller. 

2. Mark up or label all cables to the controller to ensure correct re-fitting later. 

3. Mark up or label the position of the controller and the brackets. 

4. Unplug all cables to the controller. 

5. Unplug all connectors to the controller. 

6. Check the cables for wear. If damaged, the cables must be replaced.  

7. Check that the pins in the connectors are clean and do not show signs of corrosion. 

8. Loosen the controller and remove the brackets on the controller. 

9. Slide the controller out through the side hatches of the ScanFish III. 

10. Slide in the new controller. Important: Make sure the new controller is inserted in 

the correct direction. 

11. Fasten the controller with the brackets – make sure it aligns with the markings. A 

misaligned controller may shift the weight of the ScanFish III and result in partially 

lost control. 

12. Spray all connectors with thin silicone oil before reconnecting. 

13. Plug in all cables – make sure that they match with the markings made. 

14. Refit both side hatches. 
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15. Perform ScanFish III calibration – see Section 9.8 ‘Calibration of the ScanFish III 

Controller’. 

16. Position the ScanFish III on deck (or for the ScanFish Tropheus only, in the cradle). 

17. Perform a pre-flight check to ensure that the system is fully functional.  

12.7 Replacing the altimeter 

 
Figure 108 Altimeter and its location in the ScanFish III 

The altimeter is located on the bottom side of the ScanFish III. 

Important: Never disassemble the altimeter sensor. It is a pressure-tested sensor, and the 

warranty is void if disassembled. Please use a new spare altimeter sensor and send the 

faulty altimeter to EIVA for repair.   

1. Remove the left/port top hatch. 

2. Unplug the altimeter cable at the altimeter. 

3. Unscrew the inner altimeter bracket from the skeleton. 

4. Unscrew the four screws in the shell. 

5. Unplug the connectors and remove the faulty altimeter. 

6. Mount the new altimeter sensor with the four screws. 

7. Mount the inner altimeter bracket on the skeleton. 

8. Check the cable for wear. If damaged, the cable must be replaced.  

9. Check that the pins in the connectors are clean and do not show signs of corrosion. 

Spray the connector with thin silicone oil before reconnecting.  

10. Plug in the altimeter cable. 

11. Refit the left/port hatch. 

12. Position the ScanFish III on deck (or for the ScanFish Tropheus only, in the cradle). 

13. Perform a pre-flight check to ensure that the system is fully functional 
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12.8 Replacing the locking ring and cotter pin in the 

foldable tow arm (ScanFish Tropheus only) 

The locking ring and cotter pin must be replaced if corroded, broken or missing. Never 

deploy the ScanFish III with corroded, broken or missing parts. 

1. Dismount the foldable tow arm from the ScanFish III and external sonar. 

2. Place the foldable tow arm with the locking ring facing upwards. 

3. Dismount the cotter pin and discard. 

4. Dismount the locking ring and discard. 

5. Important: Never disassemble any other parts in the foldable tow arm besides the 

locking ring and cotter pin 

6. Mount the new locking ring. 

7. Mount the new cotter pin and make sure to split and wrap it around the spindle, so it 

does not fall out. Make sure to wrap it all the way around so as to avoid sharp 

edges, as this may damage the cable between the ScanFish III and the side-scan 

sonar. 

 
Figure 109 Foldable tow arm with cotter pin and locking ring circled 
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13 Assembly of the cradle (optional) 

13.1 Cradle parts 

 
Figure 110 ScanFish III cradle parts (rubber liners not shown here) 
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13.2 Assembly of the ScanFish III support stands 

 

Item Quantity  Part number Description 

1 1 CR-13 cradle vertical cross plate, long  

2 3 CR-15 cradle cross plate for strap  

3 2 CR-31 cradle outer side plate  

4 1 CR-18 cradle vertical cross plate, short  

5 1 CR-22 cradle short table  

6 1 CR-19 cradle rubber side liner  

7 2 CR-25 cradle liner rail A  

8 4 CR-24 cradle liner rail B  

9 2 CR-27 cradle liner rail D  

10 24 ISO 7380 – M12 x 50 Hexagon socket button head screw 

11 18 ISO 7380 – M8 x 25 Hexagon socket button head screw 

Table 17 Parts list for the support stands 

 
Figure 111 Assembly of the support stands 
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13.3 Assembly of the sonar support pad 

 

Item Quantity  Part number Description 

1 2 CR-41 cradle table support  

2 1 CR-37 cradle sonar table  

3 1 CR-23 cradle rubber table liner  

4 2 CR-24 cradle liner rail C  

5 4 ISO 7380 – M12 x 50 Hexagon socket button head screw 

6 8 ISO 7380 – M8 x 25 Hexagon socket button head screw 

Table 18 Parts list for the sonar support pad 

 

 

 

Figure 112 Assembly of the sonar support pad 
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13.4 Final assembly of the cradle 

 

Item Quantity  Part number Description 

1 2 ScanFish III support stand  

2 1 Sonar support pad  

3 2 Lower frame  

4 2 CR-25 cradle liner rail B  

5 28 ISO 7380 – M12 x 50 Hexagon socket button head screw 

Table 19 Parts list for the cradle 

 

 
Figure 113 Final assembly of the cradle 
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14 Version descriptions 

Version number/date Description 

2.0 / 02.10.2014 
First release of combined ScanFish III ROTV and ScanFish III Flight software 

manual 

2.1 / 20.03.2019 Update of mechanical sections 

  

  

Table 20 Version descriptions 


